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Legal Notices

© Innovative Interfaces Incorporated and/or its affiliates. All rights reserved. All
trademarks shown are the property of their respective owners.

The information contained herein is subject to change without notice and is not
warranted to be error-free. If you find any errors, please report them to us in writing.

The software and related documentation are provided under an agreement containing
restrictions on use and disclosure and are protected by intellectual property laws. Except
as expressly permitted in your agreement or allowed by law, you may not use, copy,
reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform,
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interoperability, is prohibited.
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Polaris 6.7

Setting Up EDI Ordering

Innovative Interfaces offers a separately-licensed set of services for setting up,
implementing, and supporting Electronic Data Interchange (EDI) ordering and invoicing.
EDI services include support for Enriched EDI orders, shelf-ready items, and Advanced
Shipping Notices (ASN). If you are interested in implementing EDI ordering through
Polaris Acquisitions, contact your Polaris Site Manager.

Once you have implemented EDI with a supplier, your library can send electronic
purchase orders and receive acknowledgments and invoices electronically (and
advanced shipping notices, if the supplier produces them) using electronic data
interchange (EDI) and Polaris Acquisitions.

After the supplier receives the EDI order, an electronic order acknowledgment is put into
the library’s account folder on the supplier's FTP server. If the supplier can produce
Advanced Shipping Notice (ASN) files, an ASN is also put into this folder when the order
is prepared for shipment.

Then, when the order is filled, the electronic invoice is put into this folder. The SQL job
PolarisEDIAgent retrieves the files from the supplier's FTP server and loads them into a
directory in Polaris,creating an invoice with the suffix EDI. The purchase order
acknowledgment file (POA) is used to create the Electronic Purchase Order
Acknowledgment report, the ASN file is used to receive shipments in bulk, and the invoice
file is used to create the EDI invoice record in Polaris.

See also:
« About the Polaris EDIAgent Job
« EDIAgent and EDIFTP Logs

« Prepare for EDI Ordering

Setting Up Importing and Bulk Adding

Specify the EDI FTP transmission mode

© 2020 Innovative Interfaces, Inc.
Page 5



Polaris 6.7

About the Polaris EDIAgent Job

Tip:

You can change the EDIAgent schedule through SQL Server Enterprise
Manager. For more information on the EDIAgent and SQL jobs, see the
Administration Guide, Default Permissions Reference.

The SQL job, Polaris EDIAgent, runs on a default schedule of 8:00 a.m. every morning
and scans the supplier's FTP server looking for files in the library’s directory. The
EDIAgent identifies the supplier's FTP server by the address in the FTP Address field and
the library’s directory by the Username and Password fields in the Supplier record.

The first time the EDIAgent is run, it creates the EDINew directory
(C:ProgramData\Polaris\[version]\datalink\EDIAgent\EDINew) and the EDIDone
directory (C:ProgramData\Polaris\[version]\datalink\EDIAgent\EDIDone). (The datalink
portion of the file path depends on how your library server is set up.)

When the EDIAgent finds electronic purchase order acknowledgment, invoice, or
advanced shipping notice files in the library’s account directory on the supplier's FTP
server, it retrieves them and loads them into the EDINew directory (or any other directory
specified in the Polaris Administration Acquisitions profile Default directory). Once the
files are loaded into the SQL database, they are moved to the EDIDone directory. If any of
these steps fail, the errors are logged in the event viewer.

If available, the files retrieved by the EDIAgent are used as follows:

o Purchase Order Acknowledgments - The purchase order acknowledgment data is
used to generate the PO Acknowledgment Report, a standard report available from
the Polaris Shortcut Bar. See Acquisitions Reports.

« EDI Invoices - The invoice data automatically creates EDI invoices in Polaris, and
you can search for these invoices by the suffix EDI. You can select the Hold partial
shipment invoices in the EDI Defaults profile in Polaris Administration to prevent
EDI invoices from being created automatically if the number of copies received
does not equal the number of copies ordered on any of the line items in the invoice.
You can generate these partially received invoices using the Process EDI Invoices
workform. See Set up EDI invoice defaults.

« Advanced Shipping Notices (ASN) - The ASN (X12 transaction set 856) is com-
posed of data related to the shipment, orders, packages or cartons, and the items
inside the cartons. When the shipment arrives, the user opens the Receive ASN
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Shipments workform and receives the purchase order line items by scanning the
UCC-128 barcode on the outside of the carton. See Receive using the Advanced
Shipping Notice (ASN).

© 2020 Innovative Interfaces, Inc.
Page 7



Polaris 6.7

EDIAgent and EDIFTP Logs

The EDIAgent and EDIFTP log files are saved in the following location:
C:\ProgramData\Polaris\[version]\Logs\SQLJobs.

When the EDIAgent runs, one file for each EDI-enabled Polaris supplier record will be
created (or overwritten if already created for the supplier) and saved in the EDIFTP folder.
If the EDIAgent log reports a connection failure, a Polaris representative or authorized
library staff member can use the supplier ID to find the file in the EDIFTP folder.

EDIAgent Log and FTP Message Examples

If the FTP transmission is successful and files are retrieved, the EDIAgent log provides
information regarding the date and time the EDIAgent ran, the information retrieved for
each supplier, and the EDI Invoice e-mail sent to the library staff member. If the FTP
transmission is successful, but no files were available for retrieval, the EDIAgent log
indicates that the transmission was successful, but no files were retrieved. If the FTP
transmission is unsuccessful, the EDIAgent shows the error, and the EDIFTP file for the
supplier contains more details regarding the problem.

« EDIAgent Log - FTP transmission successful and files retrieved
Began Executing 2017-04-30 10:35:13
Start EDI expired data cleanup [SQLSTATE 01000]
Ermo O
finished EDI expired data cleanup [SQLSTATE 01000]
Run the EDIAgent executable [SQLSTATE 01000]
output
Accessing FTP Server ftp.polarislibrary.com for Supplier ID: 77
InternetConnect - File Transfer on FTP Server ftp.polarislibrary.com successful.
Accessing FTP Server ftp.polarislibrary.com for Supplier ID: 234
InternetConnect - File Transfer on FTP Server ftp.polarislibrary.com successful.
Accessing FTP Server ftp.polarislibrary.com for Supplier ID: 296
InternetConnect - File Transfer on FTP Server ftp.polarislibrary.com successful.

Processing files AudioBookR2.txt

© 2020 Innovative Interfaces, Inc.
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Copying file AudioBookR2.txt to Done directory
Processing files AudioGoR2.txt

Copying file AudioGoR2.txt to Done directory
Processing files BrodartR2.txt

Copying file BrodartR2.txt to Done directory
Processing files BTR2.txt

Copying file BTR2.txt to Done directory
Processing files FindAwayR2.txt

Copying file FindAwayR2.txt to Done directory
exiting EDIAgent

There were no errors in the EDIAgent process, invoice creation starting [SQLSTATE
01000]

Emailing file at location: "C:\ProgramData\Polaris\
[version]\EDIAgent\EDIlInvoiceResults_FindawayWorld_SAL.log" To =
staffone@polarislibrary.com; stafftwo@polarislibrary.com From =
yourlibrary@polarislibrary.com [SQLSTATE 01000]

Apr 302017 10:35AM ""C:\Program Files (x86)\Polaris\
[version]\Bin\PolarisEmailer.exe" Newman-R2
"staffone@polarislibrary.com;stafftwo@polarislibrary.com”
"yourlibrary@polarislibrary.com" EDIInvoiceResults_FindawayWorld_SAL.log
"C:\ProgramData\Polaris\4.1R2\EDIAgent\EDIInvoiceResults_FindawayWorld_
SAL.log" [SQLSTATE 01000]

output

(null)

Apr 30 2017 10:35AM Edi Agent Invoice Creation Successful [SQLSTATE 01000]
Apr 30 2017 10:35AM Edi Agent completed with no errors. [SQLSTATE 01000]
EDIAgent Log - FTP successful, but no files retrieved

Starting EDIFTP - 4/17/2017 9:24:56 AM

Number of files retrieved: 0

Finishing EDIFTP -4/17/2017 9:24:57 AM
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o FTP message - FTP successful, but no files created in Polaris
« EDIAgent Log - FTP unsuccessful
Starting EDIFTP -4/17/2017 9:30:21 AM
This EDI Agent FTP experienced the following error.
Exception Message: The remote server returned an error: (530) Not logged in.
Response Status: 530 Not logged in.
If error code = 530, check username and password.
Number of files retrieved: 0
Finishing EDIFTP -4/17/2017 9:30:22 AM

« FTP message - FTP unsuccessful

Prepare for EDI Ordering

To enable EDI ordering with Polaris, your IT staff verifies that orders can be sent via FTP;
your administrator grants permissions, sets EDI invoice defaults and verifies the library
SAN is in the Branch workform; and your library staff member contacts the suppliers that
accept EDI orders, contacts your Polaris representative, and sets up supplier records.

Prepare for EDI Ordering - IT Staff

m Verify that your library can send and receive files via FTP - Electronic Data Inter-
change (EDI) orders are sent via File Transfer Protocol (FTP), and purchase order
acknowledgments and invoices are received via FTP. Therefore, your library must
be able to send outbound files and receive inbound files via FTP, and staff mem-
bers who send EDI orders must have the appropriate administrative settings to
send an order via FTP from their workstations.

m Determine if EDI files should be transmitted in active or passive mode - When you
transmit or receive files via FTP in active mode, both the server and client are
required to open up ports to check for incoming traffic. This can cause problems
when you are working behind a firewall. However, when you transmit or receive
files via FTP in passive mode, only the server is required to open up ports forincom-
ing traffic. If you are working behind a firewall, transmitting and receiving via FTP
in passive mode gives you a better chance of being able to connect to an FTP
server.

© 2020 Innovative Interfaces, Inc.
Page 10



Polaris 6.7

Prepare for EDI Ordering - Polaris Administrator

m Set the transmission mode to active or passive in Polaris Administration - Your IT
staff determines whether the transmission mode should be set to active or passive.
Then, the Polaris Administrator sets the Acquisitions/Serials parameter Transmit
EDI files in passive mode FTP to Yes for passive mode or No for active mode. The
parameter’'s default setting for all new installations of Polaris is Yes (passive
mode). See Specify the EDI FTP transmission mode.

m Grant permissions to staff who send EDI orders - Any staff member who sends EDI
orders requires the permission Send electronic purchase orders. Additional per-
missions are required for importing, receiving shelf-ready materials, processing EDI
invoices and receiving via the Advanced Shipping Notice (ASN).

m Enter the library SAN in the Branch workform - The library SAN must be entered in
the Branch workform for each branch that sends EDI orders.

m Set up EDI invoice defaults - Select the EDI Invoice Defaults Acquisitions profile in
Polaris Administration. See Set up EDI invoice defaults.

m Verify call number setup - If you will be generating on-order items with call num-
bers pulled from the linked bibliographic records, verify that the Polaris Admin-
istration Cataloging profile Bring call number fields from bib to item record when
link is made is set to Yes. If this profile is set to Yes, call number information is
copied from the linked bibliographic record to the on-order items according to the
settings in the Item Create Call Number Hierarchy database table. The system
checks the On-order Item template's shelving scheme and assigned branch to
determine the Item Create Call Number Hierarchy table settings to use. The call
number information in the bibliographic record supersedes any call number inform-
ation that may be in the On-order ltem template. However, if the item template con-
tains call number subfields that are not in the linked bibliographic record, the data
in the template is used. For example, if the bibliographic record has a class and cut-
ter number but no prefix or suffix, and template does contain a prefix and suffix,
the resulting on-order item will contain the class and cutter number from the bib
and the prefix and suffix from the template. See the Cataloging Administration PDF
Guide, Copying Bib Data to ltems.

m Add links to supplier databases - (Optional) You can add a link from Polaris to your
suppliers’ Web databases so you can access them directly from Polaris. After set-
ting up the links, you can go to Utilities, Acquisitions Processing, Link to supplier
databases and select the supplier. You will still need to log in with a username and
password on the supplier’s site. See the Acquistions Administration PDF Guide, Add
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links to supplier databases.

m (Optional) If your library receives shipments via ASN, set option to print workslips.
To allow purchase order line item workslips to be printed in batch from the Receive
ASN Shipments workform, set the PO line item workslips: Batch print during ASN
receiving Acquisitions parameter to Yes in Polaris Administration.

Prepare for EDI Ordering - Library Staff

m Contact your suppliers that accept Polaris EDI orders - Tell the supplier your library
will be sending EDI orders (X12 format) via the Polaris Integrated Library System. If
you are a new Polaris customer who previously sent EDI orders using a different
ILS, tell the supplier your library now uses Polaris. Then get the following inform-
ation from the supplier, and record it so that you can enter it in the Supplier record
in Polaris.

Tip:

You may also want to check the supplier’s limit for the number of
characters in an EDI purchase order number. Polaris automatically checks
the purchase order length and blocks the release of the order if it exceeds
the supplier’s limit.

ggrt:é suppliers use the account number in the EDI transmission, while
others use a SAN as the account number.

« Supplier's Standard Address Number (SAN)

« Library’s Account number

» Username

« Password

« Supplier's FTP address

« Supplier's purchase order directory for incoming EDI orders

« Supplier's POA/ INV directory for outgoing purchase order
acknowledgments and invoices

« Supplier's purchase order file extension
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m (Optional for libraries interested in shelf-ready materials) Verify that the supplier
accepts Enriched EDI Orders - If your library is interested in getting “shelf-ready”
materials from the supplier, verify that the supplier accepts Enriched EDI Orders.
Enriched EDI orders include additional branch-specific information so the supplier
can provide embedded holdings data in the full MARC records it returns. When the
MARC records are imported into Polaris, the brief bibliographic records are overlaid,
and the on-order item records are updated so that the materials are ready for cir-
culation with minimal processing. The cataloging services offered and the costs
differ among suppliers. See Enriched EDI Orders and Shelf-Ready ltems.

m (Optional for libraries interested in receiving via the Advanced Shipping Notice) Ask
if the supplier can send an Advanced Shipping Notice (ASN) - If the supplier can
produce an ASN, you can receive cartons of materials by scanning a barcode on
the outside of the carton. See Receive using the Advanced Shipping Notice (ASN).

Important:

If you are implementing ASN processing with a supplier to whom you have
already sent EDI orders, before you enable ASN in the supplier record,
make sure the Hold partial shipment invoices are created for the day when
ASN processing will begin by following these steps:

« Ask the supplier the exact date when they will start producing ASN files.

« In the morning of the day the ASN processing will begin, wait until the
Polaris EDIAgent has run and all remaining EDI invoices for that sup-
plier have been created automatically. If your library does not process
partial EDI invoices separately (the Hold partial shipments box is
unchecked in the EDI Invoice Defaults profile), skip the next step.

« If the Hold partial shipment box is checked in the EDI Invoice
Defaults profile for your library organization, go to the Process EDI
Invoice workform as soon as the EDIAgent runs, and create the invoices
for this supplier.

« After the invoices are created automatically via the EDIAgent, or manu-
ally via the Process EDI Invoices workform, enable ASN processing by
checking the ASN box in the Supplier Record workform. See Enter the
supplier’s EDI ordering data.

m Contact your Polaris Implementation or Site Manager - After getting the inform-
ation from the suppliers to whom you are sending EDI orders, contact your Polaris
Implementation Manager or Polaris Site Manager and tell them the names of the
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suppliers to which you plan to send EDI orders; whether you plan to send enriched
EDI orders and receive shelf-ready materials; and whether you plan to use the
Advanced Shipping Notice (ASN) for any of the suppliers that offer this func-
tionality. Then request a license from Polaris to enable EDI ordering.

Set up supplier records for EDI ordering - With the help of your Polaris Imple-

mentation or Site Manger, enter the supplier's account information in the Supplier
record in Polaris Acquisitions. See Enter the supplier's EDI ordering data.

Setting Up Importing and Bulk Adding

Importing bibliographic records with 970 subfield data and then bulk adding them to a
purchase order is the most efficient way to create purchase orders in Polaris, whether or
not the orders are sent via EDI. When bibliographic records are bulk added to a purchase
order, the bibliographic title-level information creates each purchase order line item, and
the following subfield data in the 970 tags creates the distribution grid, or segments, for
each line item:

Note:
The collection information, material type, and non-public note are not
required to create a segment.

1:1pe. subfields can be in any order in the 970 tag.
Sl - location (Polaris branch abbreviation)
$q - quantity
$f - fund (Polaris fund name or fund alternative name)
Sc - collection (Polaris collection abbreviation)
Sp - price
$m - material type (Polaris material type name or code)

$n - non-public note (appears on the Instructions to Supplier view of the Purchase
Order Line Item workform)

Sh - item template code. If the supplier supports copy-level information in subfield
h, it is used in the creation of on-order items. The library creates item templates
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with the copy-level code in the template name. When the purchase order is
released, the item template codes in the purchase order line item segments are
matched to the template code and create the on-order items. For more information,
see the Acquisitions Guide, Matching With ltem Template Codes.

If a price is not in the MARC record’s 970 Sp, the system checks for the price in the
following tags:

« 020 -If an ISBN is present in 020 $a, the corresponding 020 Sc is checked for a
price. If both are found, the ISBN is copied to the purchase order line item’s
ISBN field, and the price is copied to the purchase order line item’s Unit price field.

« 024 -If no price is found in the 020 Sc, the system checks for a 024 $a with a first
indicator of 3, and if present, the corresponding 024 Sc is checked for a price (in
OCLC records, the 13-digit ISBN and the accompanying price are in the 024 tag, if
the first indicator is a 3). If both are found, the number in the 024 $a is copied to
the purchase order line item’s ISBN field, and the price is copied to the purchase
order line item’s Unit price field.

To set up importing and bulk adding in Polaris, the Polaris Administrator grants
permissions for importing and bulk adding, and sets up Administration profiles and
parameters. Library staff members set up the distribution grids at suppliers’ web sites
and set up import profiles for acquisitions.

Set Up Importing & Bulk Adding - Polaris Administrator

m Grant permissions to staff who manage import jobs - The Cataloging permission
Manage import jobs for this organization: Allow should be granted to senior-level
cataloging staff to allow them to stop import jobs and specify blackout times for
the system or branch organization.

m Grant permissions to staff who manage import profiles - The Cataloging per-
missions Import profiles: Access, Create, Modify, and Delete should be granted to
senior-level cataloging staff. It is important to limit the permissions to modify
import profiles because the correct settings are essential for successful creation of
the purchase order line item segments. To copy an existing profile, a user must
have the permissions: Import profiles: Access, Create, and Modify.

m Grant permissions to staff who import records - Staff members who import records
can be granted either of the following permissions:

o Import bibliographic, item and authority records: Allow - Staff members can
make changes to settings on any tab in the Polaris Import Setup window.
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They can access the Polaris Import Setup window by selecting Utilities,
Importing, Full Import.

o Express importing: Allow - Staff members can make changes to settings on
the Profile setup and the Record set tabs in the Polaris Import Setup window,
but they cannot make changes on any other tab. They can access the Polaris
Import Setup window by selecting Utilities, Importing, Express Import. This
permission allows staff members to import records without full cataloging
permissions.

m Grant permissions to staff members who bulk add records from record sets and
create purchase orders. For information on the permissions required to order mater-
ials, see the Acquisitions Guide, Order Materials Permissions.

Set Up Importing & Bulk Adding - Library Staff

m Copy the Polaris read-only profile Acquisitions bibs - Select Utilities, Importing, Pro-
file Manager to open the Profiles Manager. The Acquisitions Bibs profile is already
set up to: ignore MARC validation (because the incoming records are brief); check
duplicates and if duplicates are found, retain the 970 tags from the brief records
while keeping the full bibliographic records. Select the Acquisitions bibs profile,
right-click, and select Copy. Then, for each of your suppliers, type the supplier's
name or abbreviation in the Name box and a description for the profile in the
Description box. For more information, see the Cataloging Guide, Setting Up Import
Profiles .

= (Optional) Copy the Enriched EDI Orders profile - If you are importing records from
a supplier that provides shelf-ready cataloging, select the Enriched EDI
Orders read-only import profile, right-click, and select Copy. Then, name it with the
supplier's name. The Enriched EDI Orders profile is set up to import full bib-
liographic records containing embedded holdings data. The holdings data auto-
matically updates on-order items to fully-cataloged items.

m Set Up Bulk Add in Polaris - Use the following Polaris Administration parameters:

Note:

You can clean up 970 tags that are marked as processed using the Polaris
Administration profile $9 Cleanup Utility. See the Cataloging
Administration Guide, Set up the Subfield 9 cleanup utility.

« Bulk Add to PO: Replace Invalid Fields with Default Data - This
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parameter specifies default information that is used to create segments
if data is missing in the imported records’ 970 tags. If you are using a
Web-based selection tool at your supplier’s site, you can set this para-
meter to No so missing or inaccurate information appears in the import
log, rather than creating default segments in your purchase orders.

« Bulk add to PO/SL: Mark 970 data as processed - Set this parameter to
Yes so that each 970 tag is updated with a subfield 9 ($9) indicating
the date and time the tag was used to create a line item segment. If the
title is ordered again using the same bibliographic record, the previous
970 tags will not be used again and new 970 tags will be used to create
the purchase order line item segments. it is recommended that you
leave this set to Yes (the default setting).

« Bulk Add to PO: Add Alert to PO line item for multiple ISBNs
This parameter specifies whether the Alert check box is automatically
checked for purchase order line items created from bulk-added bib-
liographic records with more than one ISBN. We recommend that you
leave it set to Yes (the default).

Specify the EDI FTP transmission mode

You can specify whether EDI files are transmitted and received in passive or active mode
using an Polaris Administration Acquisitions/Serials parameter that is set at the system
level. The mode applies to all EDI orders and purchase order acknowledgments for all
EDI suppliers.

Note:
For more information on active and passive FTP modes, see Setting Up
EDI Ordering.

1. In the Administration Explorer tree view, expand the System folder.
2. Select Parameters and select the Acquisitions/Serials tab.
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Double-click Transmit EDI files in passive mode FTP.
Select Yes to transmit EDI files in passive mode, or No to transmit files in active

mode.
Select File > Save.
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Importing Records

When you select Utilities, Importing from the Polaris Shortcut Bar, there are two options
for importing: Express Import and Full Import. If you select Express Import, you can
change settings on the Profile Setup and Record Set tabs, but you cannot change the
settings for bibliographic, authority, or item records. If you select Full Import, you can
change settings on all the tabs in the Polaris Import Setup window if you have the
appropriate permissions.

Note:
Separate permissions control express and full importing. For more
information, see the Cataloging Administration Guide .

Before you can import MARC or MARCXML records, they must be downloaded from the
cataloging source or materials vendor and saved in a file on your computer's desktop or
in another location where you can easily find them. To select the file or files to be
imported, you click Add in the Polaris Import Setup window, and locate the file(s). If the
profile was saved with a specific import file name, the file is selected automatically (if it
exists). If the profile was saved with a directory location for the source files, the window
opens to that directory.

Note:

Importing large quantities of records may slow response times for other
processes in Polaris. Therefore, you may want to start the import process
when the library is closed and when it will not interfere with scheduled
system backups.

Print Import Reports from the Import Jobs Queue

If you want details regarding a specific import job, you can print an import report in pdf
format from the Import Jobs Queue. The Import Jobs Queue lists import jobs for both
bibliographic and authority records.

Tip:
You can also print the New Titles Imported report from the Cataloging
Reports menu. The New Titles Imported report shows the titles that were
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imported for an organization or organizations within a specific time
period. For more information, search Polaris help for "Cataloging Reports."
To print details of an import job from the Import Jobs Queue:
1. Select Utilities > Importing > Import Jobs Queue.
The Import Jobs Queue dialog box displays the details for each import job.

2. Double-click the import job you want to print. Or, select the import job and click the
Report button, or right-click and select Print Report.

3. Select File > Print from the menu.
The Import Report pdf appears in the preview window.
4. Select File > Print to print the report displayed in the preview window.
Tip:
Import reports are not saved to the local computer. To save a copy of the

report, open the report from the Import Jobs Queue, select File > Save
As, and type a file name and path.

Import Report

The first section of the report lists the selected import options and the user ID of the staff
member who imported the files.
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Following the import options, the report provides details for records that were imported,
such as: MARC validation issues; duplicate detection and overlay; item records created;
tags deleted from incoming records; tags retained from duplicate records; conflicts when
the same tag is selected for deletion and retention; and resource entities created (for

ebooks).
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Creating and Transmitting EDI Orders

Polaris allows you to create orders using various methods. For the basic workflow to
create orders, see Ordering. If you have set up the linked supplier for EDI, you can send
an order via EDI. Follow the workflow in Create a Purchase Order by Bulk Adding Titles
for an automated method of creating purchase orders. Read the following sections for
more information:

Ordering
Create a purchase order by bulk adding titles

Bulk Update Purchase Order Notes

Release a Purchase Order

Transmit a Purchase Order Electronically

Distributing/Adjusting Invoice Charges/Credits

Ordering

You have several options for ordering items, depending on your library’s acquisitions
workflow and whether orders are emailed, faxed, or transmitted via electronic data
interchange (EDI). The basic steps involved in ordering are outlined below.

1. Select titles and save the bibliographic records in Polaris using one of these meth-
ods:

« Select titles on the supplier's website - Select the titles on the supplier's
website using the distribution grid set up with your library’s location,
collection, and fund information. If your Polaris administrator has added the
links, you can go to your suppliers’ websites by selecting Utilities > Link to
Supplier Databases.

« Download the brief MARC records for the selected titles - Save the records to
your desktop or another file location.

« Import the brief MARC records into Polaris - Select Utilities > Importing >
Express Import or Full Import and select the Acquisitions Bibs profile, or an
import profile named for the supplier. In the import setup, you specify the
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record set where all the bibliographic records are gathered. For more
information, see the Cataloging PDF Guide.

2. Create a purchase order in Polaris using one of the following methods:

Tip:
For information about the types of orders you can create in Polaris,
see the Acquistions Guide, Creating Purchase Orders .

« Bulk add titles to the purchase order - Download bibliographic
records from your supplier, import them into record sets, and bulk
add titles to the purchase order. The distribution segments are
created automatically from 970 tags in the bibliographic records.

« Create a new blank purchase order - Select File > New from the
Polaris Shortcut Bar, and select a template, or create a new, blank
purchase order. Add purchase order lines and segments
manually. Line items contain information about the titles you are
ordering. Each line item contains at least one segment with the
distribution and fund information for the copies of that title.

« Copy an existing purchase order - Save the new purchase order
with a different number.

Tip:
You can also bulk add titles to a selection list and then
copy them to a purchase order.

« Copy selection list lines to a new or existing purchase order

« Use Polaris Titles to Go - Query a supplier’s site and bring back
title information to create purchase order line items.

« Renew a subscription in Serials - Purchase orders are created
automatically when subscriptions are renewed if the parameter
Create Purchase Order at subscription renewal is set to Yes in
Polaris Administration. See the Serials Guide.

3. Release the purchase order, and specify the payment method.
4. Send the purchase order to the supplier using one of these methods:
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o Fax

o Email

« Electronic data interchange (EDI)-The supplier produces an electronic order
acknowledgment that is retrieved by the Polaris EDIAgent. You can generate
the Electronic PO Acknowledgment report from the EDI acknowledgment
files. See the Polaris Basics Guide.

Important:

Your library may have collection development programs where
suppliers send many titles of a specific type or genre, but the titles
are not known until you receive the order. In these cases, you can
create an invoice without a purchase order and give it an order type
of Approval Plan or Blanket Order. Your library may refer to these
types of orders as standing orders. However, in Polaris, the order
type Standing Order is used only with serials. See the Acquisitions
Guide, Creating Purchase Orders.

See also:

« Importing and Ordering Processes

Create a Purchase Order by Bulk Adding Titles

To bulk-add titles from a record set to a purchase order, the bibliographic records must
include 970 tags. For more information, see The Bulk Add Process.

Important:

When you import bibliographic records with 970 tags, bulk add them to a
purchase order as soon as possible because another user could add 970
tags to the same bibliographic record before your 970 tags are updated
with $9, indicating they are processed. See the Acquisitions Administration

Guide.

To create a purchase order and add multiple titles at once:

Tip:
To focus the search for the record set, select Type in the Limit by box and
Bibliographic in the Value box. If you know you want to add all the records
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in the record set to the purchase order, select the record set in the Find
Tool results list, right-click and select Add to purchase order > New.

1. Select Cataloging > Record Sets from the Polaris Shortcut Bar.
The Find Tool appears.

2. Search for and select the bibliographic record set.

Note:
Provisional records cannot be used in the bulk add process.

The bibliographic record set workform appears.

3. Select Add all records to New Purchase Order or highlight specific records in the
list, and choose Add selected records to New Purchase Order.

The Add to New Purchase Order dialog box appears.

4. Choose one of the following options:

« To use a template, click Find next to the Template box, and use the Find Tool
to locate and select a purchase order template. The supplier, branch, order
type, and payment method are defined in the template. However, if the pur-
chase order template has a default line item with distribution data in seg-
ments, the segments in the template are not used in the bulk add process.
Only the data in the 970 tags or the bulk add defaults (if the parameter is set
to use this information) create the distribution information in the segments.

« To create the order without a template, select an option in the Ordered at,
Type and Method boxes, and click Find next to the Supplier box to search for
and select a supplier.

Important:

If you want the bulk add report to list records that did not get bulk
added because they lacked the correct location, collection, material
type, or fund data in the 970 tags, set the Polaris Administration
Acquisitions parameter Bulk Add to PO: Replace Invalid Fields with
Default data to No. In this case, the defaults will not be used, so you
do not need to specify defaults for the material type, destination,
collection, or fund.

5. (Optional) Select the default values in the Material type, Destination, and Col-
lection boxes.
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(Optional) Click Find next to the Fund box, and use the Find Tool to search for and
select the default fund.

7. Type the defaults values in the Quantity, List price, and Discount (%) boxes.

10.

11.
12.

13.

Type a path and name for the error report file in the File name box, or click Browse,
browse to the path, and enter a name for the file.

. Click OK to start the bulk add process.

A message box shows the progress of the bulk add process. When the processing
is complete, a dialog box appears.

Click OK to acknowledge the message.
Tip:
Print the error report each time you bulk add records to a purchase
order, and refer to it while editing the purchase order.

Open the error report to see where substitutions were made.

Use the Find Tool to search for and select the purchase order that you created
using bulk add.

The purchase order is displayed in the Purchase Order workform.

Edit the purchase order as necessary, and select File > Save.

See also:
o The Bulk Add Process

Bulk Update Purchase Order Notes

You can update purchase order line item notes in bulk from the Line Item view in the
Purchase Order workform.

The Update Note option is in the right-click menu for purchase order line items. You can
select one or more notes to update with this option.

© 2020 Innovative Interfaces, Inc.
Page 27



[ Purchase Order - 24612 - Line Items - Polaris

Polaris 6.7

e

File Edit View Links Tools Help
i 3l & '
NEHE /X 82 MmO W & E

:l‘.h .

O Number: | SAR33 | | | Status: | Pending | | 3/14/2018 |
'E Type:  |Firm Order Lnes: |21 | Total: [$398.24 | method |purchase [ ]
(@ Line It=ms

B =% o P

g O AABEFEOWSF B| &

fU Line... Title Author ISBN/ISSM Amount Orde... Rece... Inveoi.. Fund Status -
-C: 1 Intermediate English (ESL) ... 1573850020 (1... 0 0 Pending

LU._ 2 Perfecting the sounds of A...  Silverstein, ... 084420479% 0 0 Pending

: 3 Time and again Roberts, Mo... 1] 1] Pending
Q_ 5  Instantimmersion. English ... 0 0 Pending

&  Instantimmersion. English ... Place Hold 0 0 Pending
7 American English pronunda.. . o Receive 0 0 Pending
4 i . i =
ta Teach yourself. American ... Undo Receipt 0 0 Pending =
t g Teach yourself, English vo... 065 0 0 2017BR....  Pending
' ) . | I Update Note I | )
¥ 10 Common American phrases... Spears, Ric... 123 0 0 2017BR...  Pending
11 English for new Americans.... Pifieiro, Carol. 140 i Copy To ... 0 0 2017BR...  Pending
t 12 InEnglish on your own [DVD] 094 Hetnr 0 0 2017BR...  Pending
13 Crossroads Cafe [videorec... c | 0 0 2017BR...  Pending
t 14 Engish for new Americans.... 060 ance o o 2017BR...  Pending
15 Easy English : [DVD] an ES... Close 0 0 2017BR...  Pending
16  Easy English : [videorecord... Print 3 0 0 2017BR...  Pending
17 Culture dips [videorecording] . 0 0 2017BR...  Pending
18 Fast &easy. Ingles basico ... 958 Links L 0 0 2017BR....  Pending ”
= Delete =
The operation was canceled. :
; Properties N
Note:

This menu option is not enabled if any of the selected purchase order line

items have a status of Closed.

Selecting this option will open the Update Notes dialog with two note types:

« Public Note
« Non-Public Note

Both note types have the following options:

o Replace - replaces the existing note.

o Prepend - inserts the new note and a blank line before the existing note.
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o Append - inserts a blank line and the new note after the existing note.

Update Motes -
Motes
[ Public note:
Replace Prepend Append
[Inon-public note:
Replace Prepend Append
QK | | Cancel | | Help

If Replace is selected and text is not entered in the note field, the existing note will be
deleted.

Notes longer than 255 characters will be truncated to 255.

If prepending or appending causes a note to be larger than 255 characters, you will see
the following message:

Polaris -

") Prepending / appending note data to Line Mumber 1 will cause the
P |note to be truncated to 255 characters. Do you want to update the
note?

[1bo not warn me again

Yes - updates the note(s).

No - returns you to the Purchase order updating only the line items where the data
would not be truncated. The above message will appear for each line item that
may be truncated.

« Cancel - returns the user to the purchase order with the line item(s) still highlighted.
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Release a purchase order

To release a purchase order:

Important:

If you attempt to release a purchase order that has a purchase order
number exceeding the supplier's limit, you will be unable to release the
order.

Open the Purchase Order workform.

Select Tools > Release from the menu bar or click .

If no issues were found with the purchase order, a message box appears with the
prompt to generate on-order items. For information about additional messages
that may appear when you release a purchase order, see Additional Messages and

Alerts.

« Generate item records - If the purchase order is not a standing order or sub-
scription, a message asks if you want to generate item records. Click Yes if you
want the items to appear with the circulation status On-Order in the public access
catalog, click No if you do not want to generate item records, or click Cancel to
stop the purchase order release. If you generate items, the purchase order inform-
ation is transferred to the Source and Acquisition view of the ltem Record work-
form. The invoice number is displayed on this view when the invoice is paid. For
more information, see the Cataloging Guide.

Important:

If the bibliographic records linked to the on-order items have call numbers,
and the Polaris Administration Cataloging profile Bring call number fields
from bib to item record when link is made is set to Yes, the call number
information is copied to the linked on-order item records according to
settings in the Item Create Call Number Hierarchy database table.

Note:

When the purchase order is released and on-order items are generated, the
Unit price (list price) displayed in each of the purchase order line items is
copied to the on-order items, not the discount price.
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Important:

If you are releasing an enriched EDI order so that you receive shelf-ready
items from the supplier, you should generate on-order items so that the
items retain the link to the purchase order line item segment when they are
updated to shelf-ready items. If you do not create on-order items, you can
still import bibliographic records with embedded holdings data to create
shelf-ready items, but they will not be linked to a purchase order line item
segment. Only shelf-ready items that are linked to a purchase order line
item segment can be checked in and received using the Check In Shelf-
Ready Materials workform.

When the Payment Options dialog box appears, select Pay on receipt of invoice or
Prepay on the Payment Options dialog box.

If you chose Prepay, the Payment Options dialog box expands to display the
Payment Methods frame. You can select Check or Voucher, type the check or
voucher number, and select the date, but this information is not required to prepay
the order.

Click OK on the Payment Options dialog box.
When the purchase order is released successfully, the following events occur:

« The status of the order in the order status box changes from Pending to Released
(or Continuing if the order type is standing order or subscription).

« The purchase order is saved with the original purchase order number and purchase
order number suffix, but these can be changed after the order is released. If the pur-
chase order number and/or suffix is changed, the Properties sheet displays the ori-
ginal purchase order and suffix. The purchase order number/suffix is updated for
any linked on-order item records.

« The date of the release appears.
Tip:
If the purchase order is linked to a foreign supplier, the amounts
encumbered or expended are converted to the base currency according to

the current exchange rate, and the amounts are posted in the linked funds
in the base currency.

« If you selected the Pay on receipt of invoice check box, the appropriate funds are
encumbered.
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« If you selected Prepaid, the appropriate funds are expended, and an invoice is
automatically created.

« If the purchase order has a payment method of depository agreement, the
appropriate funds are debited, and an invoice is automatically created.

« If you chose to create item records upon release, the item records are created with
a circulation status of on-order. The List price in the purchase order line items (not
the discount price) is copied to the on-order items.

« The status bar indicates that the order was released successfully.

Additional Messages and Alerts

The following messages and alerts may appear when you release a purchase order:

« Purchase order release alert - There are linked bibliographic records without an
ISBN, or with the Display in PAC box unchecked. Click Display in PAC to check the
box in the bibliographic record and click Continue to release the purchase order, or
click Cancel and edit the line items before releasing the purchase order.

Tip:

To change the Display in PAC setting in the linked bibliographic records,
you must have the permission Modify a bib record from acquisitions and
serials. See the Acquisitions Administration Guide.

Important:

If you order using EDI, a line item may be rejected and automatically
cancelled by the supplier if it is missing an ISBN/ISSN. Check your
supplier's requirements.

« This supplier accepts EDI orders - If the supplier linked to the purchase order
accepts EDI orders, a message reminds you to send the order. Click OK to close the
message box.

Tip:
Releasing the order does not automatically send it via EDI; select File >
Send from the Purchase Order workform. See Transmit a purchase order

electronically.

« This supplier cannot accept orders where the PO number exceeds [X] characters. -
If the supplier linked to the purchase order has a limit on the length of the purchase
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order number allowed for EDI orders, a message tells you to change the purchase
order number to be less than or equal to the supplier's EDI purchase order number
maximum length.

Tip:

Polaris attempts to match each released line item segment with an
existing item template. See the Acquisitions Guide, Creating On-Order ltem
Templates. .

The following item templates are missing required fields. - If the system cannot
find an item template to match the branch, collection, and material type, the Item
Record Creation error message box appears. It lists the missing required fields and
alerts you that no item records will be created if a template cannot be found.

o Click No to cancel the release operation. Create an on order item template if
none exists, or correct an existing one in the Cataloging subsystem. See the
Acquisition Guide, Creating On-Order Item Templates. .

o Click Yes to release the purchase order without creating item records. An error
condition will result. Even in the event an item template code match is done,
no item template will be found. You can create the item records when the
items are received, although if you are outsourcing your cataloging through
enriched EDI, correcting the error is encouraged.

Foreign currencies - If the linked supplier uses a currency other than your base
currency, the currency code appears next to Amount; for example, Amount (USD) if
your base currency is Canadian Dollars, and the linked supplier uses U.S. dollars. If
you need to change the exchange rate, click Cancel and select Utilities > Update
Currency Exchange Rate. You must have the Polaris Acquisitions permission
Adjust currency exchange rate: Allow. See the Acquisitions Guide, Update the
currency exchange rate for a foreign currency .

o Exceeding or adjusting encumbrance limits - If you selected Pay on
receipt of invoice, a dialog box appears if there is insufficient money in
the fund.

o Click OK to continue. The Overencumbrance List dialog box appears.

o Click Continue to overencumber the funds and exceed the negative free
balance. You must have the permission Release order exceeding fund
encumbrance limits.
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o Click Adjust Funds to adjust the fund limits in the fund record. See the
Acquisitions Guide, Adjust fund limits. Then, you can release the
purchase order.

« Exceeding or adjusting expenditure limits - If you selected Prepay, and there is
insufficient money in the fund or if the fund expenditure limits will be exceeded, the
Overexpenditure List dialog box appears.

o Click Continue and release the order. You must have the permission
Release order exceeding fund expenditure limits.

o Select a fund and click Adjust Funds to make changes in the fund. See
the Acquisitions Guide, Adjust fund limits.

Transmit a Purchase Order Electronically

After a purchase order is released, you can send it electronically if the supplier accepts
purchase orders via Electronic Data Interchange (EDI).

Important:

To communicate with a supplier via EDI, you must first contact your
Polaris Site Manager or Implementation Manager to obtain a license, then
contact your supplier and get specific information to set up EDI ordering in
Polaris. See the Acquisitions Administration Guide. Then, set up the
supplier record with the information you gathered. See Enter the supplier's
EDI ordering data.

To send a purchase order to a supplier via Electronic Data Interchange (EDI):

Important:
Check with your supplier to find out if ISBNs are required in purchase order
line items.

1. Open the Purchase Order workform.
2. Select File > Send.
The purchase order is sent electronically via EDI.

3. To see details about the file transmission, select View > Charges. The Charges
view displays the EDI file name, Date created, and Time created boxes filled in.
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Related Information

Retransmitting a purchase order - If you get the EDI File Sent Warning message that
the purchase order was transmitted to the supplier, click Continue to retransmit the
purchase order, or click Cancel if you do not want to retransmit the order.

Note:
You may want to check with your supplier before retransmitting the order,
to avoid filling the order twice.

Enriched EDI Ordering overview - See Enriched EDI Orders and Shelf-Ready Items.

Setting up EDI ordering - To communicate with a supplier via EDI, you must first
contact your Polaris Site Manager or Implementation Manager to obtain a license.
Then contact the supplier and get specific information to enter in Polaris. See the
Acquisitions Administration Guide.

Entering EDI information in the Supplier record - Set up the supplier record with the
information you gathered from the supplier. See Enter the supplier's EDI ordering
data.

Polaris EDIAgent - The Polaris EDIAgent is a SQL job that scans the supplier’s file
transfer protocol (FTP) server for files in the library’s directory, retrieves the files,
and saves them in the Polaris database. For more information, see the Acquisitions
Administration Guide.

Electronic Purchase Order Acknowledgment - After the supplier receives the EDI pur-
chase order, if the supplier uses EDI confirmations instead of email, an electronic
purchase order acknowledgment is placed on the supplier's FTP server. The Polaris
EDIAgent retrieves the file and saves it in a directory on the library’s server. You can
generate the Electronic Purchase Order Acknowledgment from the Utilities menu.
See the Polaris Basics Guide.

Receiving the EDI invoice - After the purchase order is received, the supplier puts an
invoice on their FTP server. The Polaris EDIAgent picks up the file and uses the
data in the invoice file to create one or more invoice records in Polaris. For more
information, see Review automatic EDI invoices.
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You can distribute charges, credits, and discounts across multiple line items and
segments within an invoice. Distributing charges is useful for libraries that do not use a
centralized fund to pay for the charges on the invoice. For example, the supplier charges
a certain amount for shipping the entire order, but each branch has its own fund from
which it pays shipping charges. You can distribute the shipping charges equally among
all the line items’ segments within the invoice. Similarly, a discount or credit can be
applied to all the invoice lines.

You may find that your paper invoice from the supplier does not match the invoice in
Polaris. In this case, you can adjust the amount of a charge or credit on an individual
segment of the open Polaris invoice by typing the amount in the appropriate box on the
Charges tabbed page of the invoice line item segment.

When distributing charges or credits, Polaris treats prepaid and open invoices differently.
Since prepaid invoices have transactions already posted to linked funds, distributing
charges or credits across a prepaid invoice causes fund adjustments. With open
invoices, the funds have not been expended, so no funds are adjusted.

See also:

« The Acquisitions PDF Guide, Distributing Charges
« The Acquisitions PDF Guide, Distributing Credits and Discounts
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Receiving EDI Orders

You can receive EDI orders in various ways depending on your library’s workflow and
your supplier's process. Most EDI receiving methods are set in the EDI Invoice Defaults
profile in Polaris Administration. If a supplier record has the ASN Shipments box
checked, automatic EDI invoices are not created for that supplier until the materials have
been received via ASN.

Receive an EDI order automatically - To use this method, the Update linked purchase
order line items to received box must be selected on the EDI Invoice Defaults profile in
Polaris Administration. As soon as the Polaris EDI invoice is automatically created from
the supplier’s invoice file, the linked purchase order line items are updated to a Received
status. The EDI Invoice Defaults profile can also be set to update the circulation status
of the linked on-order items. If you do not want partial shipment invoices to be created
automatically, you can select the Hold partial shipments option. See Set up EDI invoice
defaults.

Receive an EDI order from the invoice - If your library policy requires the shipment of
materials to be at the library before the order is received, leave the Update linked PO line
item to received box unchecked in the EDI Invoice Defaults profile. See Set up EDI
invoice defaults. The EDI invoice is still created automatically, but the linked purchase
order line items are not received automatically. See Receive line items from an invoice.

Receive an EDI order from the Receive ASN Shipments workform - If the supplier can
provide an ASN (X12 transaction set 856) with shipment information, you can receive
materials by scanning the tracking barcode on the outside of the carton. You create and
transmit an order to a supplier that produces ASN files the same way you create and
send any EDI order. The linked supplier record contains the ASN setting. After the EDI
order is received and processed, the supplier outputs the ASN file to the library’s directory
on the supplier's FTP server. The Polaris EDIAgent utility scans this directory, retrieves
the ASN file, and loads the data into Polaris. See Receiving via EDI Advanced Shipping
Notice.

Receive an Enriched EDI order from the Check In Shelf-Ready materials workform - If your
library sends enriched EDI orders, circulation staff can receive shipments of shelf-ready
items, which updates the circulation status of the items so they can circulate and
receives the linked purchase order line item segments at the same time. See Checking In
Shelf-Ready ltems.
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See the following topics for more information:

Set up EDI invoice defaults

Receive Line Items from an Invoice

Process EDI Invoices for Partial Shipments

Review Automatic EDI Invoices

Check In New Shelf-Ready ltems

Set up EDI invoice defaults

When the EDI invoice is created, the invoice line items are automatically linked to
purchase order lines, if there is a matching purchase order line item. Additionally, you
can set up invoice defaults that create an invoice line item if no matching purchase order
line item is found. The EDI Invoice Defaults profile can be set to update the linked
purchase order line item to received as soon as the invoice is saved in the Polaris
database, or you can choose not to automatically receive the purchase order line item,
and receive later when the shipment arrives.

If no matching bibliographic record is found, the invoice line item is created using all the
information in the EDI Invoice Defaults profile. Polaris searches for a matching ISBN in
the database, and if one is found, the invoice line item is created from the title
information in the bibliographic record and the information in the EDI Invoice Defaults
profile. If the default information is used to create an invoice line item, it appears on the
error log, so you can update the invoice line item with accurate information.

Note:

When the defaults are used to create an invoice line item, an exclamation
point appears next to the line item in the Find Tool results list and the line
items view of the Invoice workform.

The dialog box for the EDI Invoice defaults profile also includes options for
automatically updating the linked purchase order line item, loading header funds,
updating the item records linked to the purchase order, and preventing the automatic
creation of EDI invoices when any of the line items has a quantity sent less than the
quantity ordered. See the Acquisitions PDF Guide, Receiving Orders.

Tip:

If no matching purchase order line item can be found, or if the matching

© 2020 Innovative Interfaces, Inc.
Page 38



Automated Acquisitions Guide

purchase order line item has an incorrect status, a red exclamation point
icon appears next to the invoice line item in results list and in the Line
ltems view of the Invoice workform. Check the e-mail log if you see this
icon.

To set up the defaults for EDI invoices:

1. In the Administration Explorer tree view, select the organization’s folder.
2. Select Profiles and select the Acquisitions/Serials tab.

3. Double-click EDI Invoice defaults.

The EDI Invoice Defaults dialog box appears.

EDI Invoice Defaults [Community Library (br)]

If no corresponding PO line is found:

Title: Mo PO Line is Found
Destination: | Community Library {COE) W Segment fund: | ElERIERRE W

Alert note: | This is an alert Note

If charges are present: If a corresponding PO line is found:
Update linked PO line item to received

Load supplier header charges
[ Jupdate on-order item circulation status

Header fund: | .md fund1 {mdf) {md fy 4) W Hold partial shipment invoices

Send invoice log email to:

Email addresses: | test@test.com

4. Type the default title in the Title box.

Example:
Enter No PO line found in the Title box to indicate that the invoice
line item was created using default information.

5. Select the default destination in the Destination box.

Tip:
If you have specified default funds for segments and header
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charges, the funds will be updated to the new funds automatically
during the fiscal year rollover process. See the Acquisitions
Administration PDF Guide, Managing Fiscal Year Rollovers .

6. Select the default fund for the segment in the Segment fund box.

If you want an alert note to appear in the Additional Information view of the Invoice
Line Iltem workform when defaults are used to create an invoice line item, type a
note in the Alert note box.

Note:

When defaults are used to create an invoice line item, an
exclamation mark automatically appears next to an invoice line item
in Find Tool search results and in the Line Items view of the Invoice
workform. You can use the alert note box to include a description for
this alert, such as “This invoice line item was created using default
information.” You can limit invoice line item search results by alert
note.

7. Specify if you want header charges loaded automatically when EDI invoices are
created:

« To load the header charges from the supplier, select the Load supplier
header charges check box, and select the fund in the Header fund box.

« To keep the header charges from loading automatically, uncheck the Load
supplier header charges box.

Note:

If you do not load the header charges automatically, you can add
them and select specific funds to use for each charge type on the
Invoice workform when the EDI invoice is created.

8. To update any matched purchase order line items to Received automatically as
soon as the EDI invoice is created, select Update linked PO line item to received.

9. If you selected Update linked PO line item to received, specify if you want to
update the linked on-order item records:

« To change the linked on-order item records to in-process automatically, select
the Update on-order item circulation status.
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« To leave the linked on-order item records with a status of on-order until the
physical item is received, uncheck the Update on-order item circulation
status.

Important:

If the Update on-order item circulation status check box is not
selected, staff members will never see on-order items with an in-
process status; they are updated to a status of In when they are
checked in through circulation.

10. To prevent EDI invoices from being created automatically when the quantity sent
does not equal the quantity ordered for any of the line items on the invoice, select
Hold partial shipment invoices.

When this option is selected, EDI invoices are created automatically only if the
quantity sent matches the quantity ordered on all line items. If the quantities do not
match, the invoice is not generated automatically. The EDI invoice reflects the
contents of the actual shipment and may contain line items (titles) that were
ordered via various EDI purchase order transactions. You can use the Process EDI
Invoices workform to generate the partial shipment invoices separately. See
Process EDI invoices for partial shipments.

11. In the Email addresses box, type the e-mail addresses of staff members to whom
you want invoice details sent. Use semicolons to separate multiple e-mail
addresses, but do not leave a semicolon at the end of an e-mail address. You must
enter at least one valid e-mail address.

Important:

If an e-mail address ends with a semicolon, the e-mail program
expects another e-mail address to follow and it fails on the blank
address. The invoices are created but no e-mails are sent.

12. Select Save to save the EDI invoice defaults.

13. Select Administration, Profiles, PAC and confirm that the profile Email Noti-
fication: Server running SMTP service displays your library’s e-mail server name.

Related Information

« EDIInvoice log E-mail - The e-mail message is a log of the generated invoice files
that the EDIAgent picked up from the supplier’s site. If there are errors in the
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invoice, such as a line item was already canceled, the e-mail log shows the reason
for the error. If there are holds on any of the titles, they will be listed in the e-mail.
For more information on the EDI e-mail log, see The EDI Invoice E-mail Log.

The e-mail messages are created by Innovative Interfaces. However, the sender of
the e-mail is not polariscommunications@polarislibrary.com because this address
causes some libraries’ SPAM filters to reject e-mails. The sender in the From field is
whatever address is entered in the PAC profile Email notification: Email address of
sender. See Setting Public Access Profiles and Parameters.

« Generating partial shipment invoices - If you select the option Hold partial ship-
ment invoices, you can generate the invoices later using the Process EDI Invoices
workform. The invoices generated using the Process EDI Invoices workform use the
same EDI Invoice Defaults settings as automatically-created invoices.

Receive line items from an invoice

You can receive invoice line items from the Invoice workform for EDI and non-EDI orders.
If you do not want purchase order line items to be updated to Received automatically
when an EDI invoice is loaded into Polaris, make sure the Update linked PO line item to
Received check box in the EDI Invoice Defaults profile is left unchecked. Then you can
receive the line items in the invoice when the actual shipment is received. See the
Acquisitions Administration Guide.

To receive one or more whole line items from the Invoice workform:

Tip:
To keep your place in the list and retain your sort order, select Edit > Lock

List View or click . When you update line items with the list view locked,
the changes do not appear in the list view until you uncheck the Lock List
View option or refresh the list. List view locked is displayed in the status
bar when this option is on.

Click . to refresh the list. After you refresh the list, your updates to the
line items appear, and the list view is resorted.

Note:
You can receive line items from the Invoice workform if there are linked
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purchase order line items. If the invoice is not linked to a purchase order,
you must receive at the invoice line item segment level.

1. Open the Invoice workform-Line Items view.
2. Select the line items you want to receive, right-click, and select Receive from the

context menu, or click .
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3. A message asks if you want to receive the selected lines.
4. Click OK to receive the selected items.

Note:

If you are receiving invoice lines, and no item records were generated when the
purchase order was released, right-click the invoice line and select Create > Item
Records from the context menu. If no errors are detected, the on-order item records
are created.

The status of any linked purchase order line items is updated to Received and the
circulation status of any linked on-order items is updated to In Process.

If there are hold requests for any title in the invoice, and the Acquisitions profile
Receiving line items: Warn if linked hold requests is set to Yes in Polaris
Administration, a message informs you that there are holds on a title or titles.
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Process EDI invoices for partial shipments

Use the Process EDI Invoices workform if your library has selected the Hold partial
shipment invoices option in the EDI Invoice Defaults profile in Polaris Administration.
When the option to hold partial shipments is selected, the raw EDI invoice data from the
supplier does not automatically create EDI invoice records in Polaris if the quantity sent
and the quantity ordered do not match for at least one title on the invoice. If all
quantities sent match all quantities ordered for all titles, the supplier's EDI invoice data is
saved automatically as an EDI invoice record in Polaris.

Note:
You must have the permission Process EDI Invoices: Allow set at the
system level to select EDI invoices to process.

To generate an EDI invoice where the quantities sent do not equal the quantities ordered:

Tip:

You can wait to process partial shipment invoices if the supplier indicates
the remainder of the order will be shipped eventually. When the supplier is
able to complete the order and sends the EDI invoice file, the completed
EDIl invoice is created automatically in Polaris.

1. Select Acquisitions > EDI Services > Process EDI Invoices from the Polaris Short-
cut Bar, click , or press ALT+A+E.

The Process EDI Invoices workform appears.
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. Enter the search criteria for the invoice as follows:

« Enter the invoice number (maximum of 30 characters).

« Enter the supplier's SAN (maximum of 7 characters).

« Enter an invoice date range by selecting dates in the From and To boxes.

. Tofilter the invoices by branch, select a branch in the Organization box. Select All
to see all partially received EDI invoices in your library system.

. Click Go.
The ungenerated invoice or invoices that meet your search criteria are listed.

. To see the purchase order line items linked to this invoice, right-click an invoice in
the list, and select Purchase Order Line Items from the context menu.

A box lists the linked purchase order line items. At least one of the purchase order
line items listed has a number of copies sent less than the number of copies
ordered. You can open a purchase order line item in its workform by double-
clicking on it.
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Note:
If the invoice is linked to only one purchase order line item, the
Purchase Order Line ltem workform appears.

6. Select the invoice or invoices in the list, right-click and select Generate selected
invoices.

The invoices you selected are generated, and they no longer appear in the list. If the
Update linked PO line items check box is checked in the EDI Invoice Defaults
profile in Polaris Administration, the linked purchase order line items are updated
to Received, and any segments that could not be received are set to On-Order. The
linked item records are either updated to in-process or remain on-order, depending
on the setting in the profile. If the Update linked PO line items check box is not
checked, the purchase order line items remain unreceived. See the Acquisitions
Administration Guide.

7. Use the Find Tool to search for and select the generated EDI invoice.

If the line items are not received automatically, you can receive them from the
invoice or purchase order. See the Acquisitions Guide, Receiving Orders.

Partial Shipments

If you hold EDI invoices for partial shipments, you can set up your distribution
profiles at your supplier’s site so the 970 tags are created first for the branches
where you need the full number of copies ordered. Then you can receive the full
number of copies for the busiest branches and split receipt for branches that can
wait for the full number of copies to arrive. For more information, see the
Acquisitions Guide, Creating Purchase Orders .

The EDI Invoice Email Log

Tip:

The EDIAgent and EDIFTP logs are created automatically, but are not
sent to library staff members. These logs provide information
regarding the FTP transfer and can be used in troubleshooting
connection failures. For more information, see the Acquisitions
Administration Guide.

When Polaris attempts to create EDI invoices from data retrieved from suppliers, a
separate log file is created for each supplier's invoice data. For each invoice, the
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log file indicates whether the invoice was created and lists details regarding any
line items that had errors. These log files are saved in the same directory as the
EDINew and EDIDone folders with the following name:
EDlInvoiceResults_(Supplier name).(Org abbreviation).log.

Examples:
EDlInvoiceResults_Baker_And_Taylor.STl.log
EDlInvoiceResults_Ingram.STl.log.

These logs are emailed to the addresses in the EDI Invoice Defaults profile with the
subject line EDlInvoiceResults and organization abbreviation. The email log lists
invoice line items that were generated, line items with errors, and line items with
bibliographic-level holds placed on the titles.

The following types of messages may appear in the email log that is sent to the
addresses in the EDI Invoice Defaults profile with the subject line EDlInvoiceResults:

« This message indicates the invoices were created successfully and some line
items have linked bibliographic hold requests:

Tip:

The holds information in the log can help you prioritize the processing of
materials that have holds if you have enabled the Update linked PO lines
to Received setting in the EDI Invoice Defaults profile. (When the purchase
order line items are received automatically, users do not see the message
that appears when manually receiving line items with holds.)

Begin processing EDI 810 file: testsal3644d.txt

Invoice # BTSAL3644e Suffix = EDI, was created.

INLI #2 on Inv #BTSAL3644e Suffix = EDI, has 1 linked holds.
Invoice # BTSAL3644b Suffix = EDI, was created.

INLI #4 on Inv #BTSAL3644b Suffix = EDI, has 2 linked holds.
Invoice # BTSAL3644d Suffix = EDI, was created.

Invoice # BTSAL3644a Suffix = EDI, was created.
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End processing EDI 810 file: testsal3644d.txt

o These messages indicate problems with the invoices:

[e]

Invoice #3014384848 may not have been created. Contact your Polaris sup-
port representative for assistance.

Inv#3014384848 has invalid IT101(s). Could not match an IT101/IT111
with a PO# in the system. Inv#3014384848 suffix=EDI was created. - The
invoice was created, but there were problems with some of the invoice line
items that did not match up with a purchase order.

The SA Profile defaults were used to create INLI# 5 on Inv #3014384848. -
An unlinked invoice line item was created using default data in the EDI
Invoice Defaults profile because no matching purchase order line item was
found. If a bibliographic record with a matching ISBN and title is found in the
Polaris database, it is used for the title of the invoice line item. If no matching
ISBN or title is found, the title is the default title in the profile, for example, No
matching PO line item was found.

The POLI# 5 on PO#BetterBooksPO1 is not linked to INLI# 4 on Inv#
3014384848 Suffix = EDI because it has the wrong status. An unlinked INLI
was created. - An invoice line item is created using information from the
matching purchase order line item, but the invoice line item cannot be linked
to the purchase order line item because the purchase order line item has a
status that prevents it from being linked.

Invoice#3014384848 Suffix = EDI was created. - The invoice was created,
but check the messages for individual invoice line items that may have prob-
lems.

The POLI# 5 on PO#BetterBooksPO1 is not linked to INLI# 6 on INV#
3014384848 Suffix = EDI because the quantity sent did not equal what was
ordered. An unlinked INLI was created. - This message appears when the
Hold partial shipment option is not selected in the EDI Invoice Defaults pro-
file. When an invoice line item indicates that the quantity sent does not equal
the quantity ordered, the invoice line item is created using information from
the matching purchase order line item, but it cannot be linked to the purchase
order line item because the quantities do not match.

EDI Inv# X Suffix= EDI has not been generated because Invoice line item
quantity sent does not equal the PO line item total quantity ordered and EDI
invoicing is set to hold partial shipment invoices. These PO lines are
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partials: [POLI ID X, POLI ID Y] - This message appears when the Hold partial
shipment invoices option is selected on the EDI Invoice Defaults profile, and
the EDI invoice indicates that for at least one line item, the quantity shipped
does not equal the quantity ordered.

Note:
To see the linked purchase order line item, use the Find Tool to search for

it by the purchase order line item ID.

Review automatic EDI invoices

EDI invoices are created automatically in Polaris using data retrieved from the supplier's
FTP server, and an email message notifies you that the invoice is available. You can
search for EDI invoices by the invoice number suffix EDI.

When an EDI invoice is generated in Polaris, a log of the invoice creation is posted to an
EDI invoice log. The log lists the invoice numbers, and includes whether one or more

titles have holds. The log also lists any errors.

For more information about the invoice log contents, see The EDI Invoice E-mail Log.

Important:
To deal separately with EDI invoices where the quantity sent does not

equal the quantity ordered, select the Hold partial shipment invoices
option on the EDI Invoice Defaults profile. Then you can generate them
using the Process EDI Invoices workform. See Process EDI invoices for
partial shipments. Also see "Set up EDI invoice defaults" in the
Acquisitions Administration Guide.

To open and review automatic EDI invoices:
1. Select Acquisitions > Invoices from the Polaris Shortcut Bar.
The Find Tool appears with Invoices selected in the Object box.

2. Select Invoice number suffix in the Search by box, and type EDI in the For box.

Note:
You can also limit by the invoice number suffix, EDI. For example,

you can search by invoice date range and limit by the EDI suffix. You
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can select a sort by option to sort the results list before it appears.
For example, you could search by the number suffix EDI, limit by
supplier, type Baker*, and sort by owner to list the Baker & Taylor EDI
invoices sorted by the owning branch.

The automatically-created EDI invoices appear in the results.

+++++

3. Double-click to open the invoice in the Invoice workform.

The EDI filename and the date the order was shipped are displayed in the workform
(if the supplier includes this information).
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4. Select View > Line Items to see the line items in the invoice.

Note:
If there are invoice line items with errors that prevented them from
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linking to purchase order line items, a red exclamation point icon
appears next to the invoice line items. The icon also appears in the
Find Tool results list for EDI invoice line items that have errors.
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5. Check your e-mail for messages regarding EDI invoice transmissions. The email
message is a detailed log of the invoices that the EDIAgent picked up from the sup-
plier's site. The log lists any bibliographic-level holds placed on the items, and any
errors in the invoice. See The EDI Invoice Email Log.

Important:
Correct any errors before paying the invoice.

6. If aninvoice line item is listed with a red exclamation point because it was not
linked to a purchase order line item, you can manually link to the purchase order
line item by doing the following steps:

a. On the Invoice Line Iltem workform, select View > Additional Information.
The Additional Information view appears.

b. Click Find.
The Find Tool appears with Purchase Order Line Item selected.

c. Search for and select the appropriate purchase order line item.
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Any information in the Invoice Line ltem workform is overwritten with the
information from the purchase order line item you selected.

Related Information

« Setting up EDI ordering - To communicate with a supplier via EDI, you must first
contact the supplier and get specific information to enter in Polaris. See the Acquis-
itions Administration Guide.

« Entering EDI information in the Supplier record - Set up the supplier record with the
information you gathered from the supplier. See Enter the supplier's EDI ordering
data.

« Polaris EDIAgent - The Polaris EDIAgent is an SQL job that scans the library’s dir-
ectory on the supplier's FTP server. When it finds files, they are retrieved and used
to create the purchase order acknowledgment and EDI invoice. If the supplier
provides an Advanced Shipping Notice (ASN), it is also retrieved by the EDIAgent.
See the Acquisitions Administration Guide.

« Electronic Purchase Order Acknowledgment - After the supplier receives the EDI pur-
chase order, an electronic purchase order acknowledgment is placed on the sup-
plier's FTP server. The Polaris EDIAgent retrieves the file and saves it in a local
directory. You can generate the Electronic Purchase Order Acknowledgment from
the Utilities menu. See the Polaris Basics Guide.

« Processing partial shipment EDI invoices - If your library has selected the Hold par-
tial shipment invoices option in the EDI Invoice defaults profile, you can generate
EDI invoices with invoice line items where the quantity sent does not match the
quantity ordered. See Process EDI invoices for partial shipments.

Check in New Shelf-Ready Items

To check in new items when a shipment of shelf-ready items arrives:

Note:
To do this procedure, you need the Acquisitions permissions Access
Acquisitions: Allow and Receive Shipment: Allow.

1. Select Acquisitions, EDI Services, Check In Shelf-Ready Materials or click
on the Polaris Shortcut Bar to display the Check-In Shelf-Ready Materials work-
form.
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If you will print hold or in-transit slips from this workform, select Tools,
Options and set up receipt printing. See the Patron Services Guide, Setting Up
Receipt Printing from Workforms.

You need to do this step only once for this workform. If receipt printing has already
been set up, skip this step.

Scan or type the barcode of the first item in the Item barcode box and press
ENTER.

The system automatically finds the barcode of the matching on-order item record,
and the item is listed in the top section of the workform.

Note:

If the item’s barcode label is damaged, you can also click Find to search
for the on-order item record, but the record must have a barcode to be
checked in on this workform.

Continue to scan items in the shipment.

As the items are scanned and checked in, they are listed in the top section of the
workform.

As the items are checked in, each item'’s circulation status is updated appropriately
(for example, to In, In Transit, or Held). If you have the appropriate permissions, you
can change item information (collection, shelf location, material type, blocks, or
non-public note) while it is displayed in the top part of the workform. See the
Patron Services Guide, Change item information at Shelf-Ready Materials check-in.

If items that fill hold requests or items that belong at another branch are checked
in, and you have set receipt printing (see step 2), the appropriate holds slips or in-
transit slips are printed. Depending on your library’s settings in Polaris
Administration, you may also see messages alerting you that an item has holds, or
that it should go to another branch. Click OK to acknowledge the message and
continue scanning items.

If you receive error messages for no matching item records or other conditions, set
the problem items aside and alert the technical services staff.

Note:

If you have entered barcodes in error, you can select the item or items in
the list and click Remove Selected Items. The items are removed from the
list. At this point the items have been checked in but not received.
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Technical Services staff can run the Acquisitions report Shelf Ready Iltems
Not Received in Acquisitions to identify these items and resolve their
status.

If you have scanned the same item twice, you can ignore the error. The
item is checked in only once.

5. After the barcodes for all the items in the shipment have been scanned or entered,
click the Accept Shipment button.

Important:

Try to scan all the barcodes for all the items in a single shipment before
clicking Accept Shipment. This reduces the number of purchase order line
item segments that are split into two segments—one for the copies
received and one for the copies still on-order—and therefore makes further
processing easier.

The scanned items appear in the bottom portion of the workform and the status of
the linked purchase order line item segments is changed to Received. The
Note column indicates how many copies were ordered and received.

Note:

You may notice that the ISBN/UPC number for an item differs in the top
and bottom part of the workform. This is because the number in the top
view comes from the linked bibliographic record, but the information in the
bottom portion comes from the purchase order line item. The data in the
purchase order line item reflects the material ordered from the vendor, so
the ISBN or UPC number in this column should match what is on the
physical item.
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Alog report is saved in the database when the shipment is received. Your library’s
technical services staff reviews the report for problems.
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Receiving via EDI Advanced Shipping Notice

Receive an EDI order from the Receive ASN Shipments workform - If the supplier can
provide an ASN (X12 transaction set 856) with shipment information, you can receive
materials by scanning the tracking barcode on the outside of the carton. You create and
transmit an order to a supplier that produces ASN files the same way you create and
send any EDI order. The linked supplier record contains the ASN setting. After the EDI
order is received and processed, the supplier outputs the ASN file to the library’s directory
on the supplier's FTP server. The Polaris EDIAgent utility scans this directory, retrieves
the ASN file, and loads the data into Polaris.

When the shipment arrives at the library, the carton has a tracking barcode label (with
the supplier number, ASN number, and carton number) affixed to the outside. The staff
member opens the Receive ASN Shipments workform and scans the barcode to bulk
receive the shipment.

If the EDIAgent retrieves an invoice file before the shipment is received via ASN, the
invoice file does not automatically create an EDI invoice in Polaris. Instead, the invoice
file is held in the Process EDI Invoices workform until the shipment is received via the
ASN. Once the shipment is received via the ASN, you can generate the invoice from the
Process EDI Invoices workform, or you can wait until the EDIAgent runs again and the
invoice is created automatically.

Implementing ASN with an EDI Supplier

If you are implementing ASN processing with a supplier to whom you have previously
sent EDI orders, before you enable ASN in the supplier record, make sure the EDI invoices
are created for the day when ASN processing will begin by following these steps:

1. Ask the supplier the exact date when they will start producing ASN files.

2. In the morning of the day the ASN processing will begin, wait until the Polaris EDIA-
gent has run and all remaining EDI invoices for that supplier have been created
automatically. If your library does not process partial EDI invoices separately (the
Hold partial shipments box is unchecked in the EDI Invoice Defaults profile) go to
Step 4.
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3. If the Hold partial shipment box is checked in the EDI Invoice Defaults profile for
your library organization, go to the Process EDI Invoice workform as soon as the
EDIAgent runs, and create the invoices for this supplier. See “Process EDI invoices
for partial shipments” in Polaris staff client online Help.

4. After the invoices are created automatically via the EDIAgent, or via the Process EDI
Invoices workform, enable ASN processing by checking the ASN Shipments box in
the Supplier Record workform. See “Enter the supplier's EDI ordering data” in
Polaris staff client online Help.

See Also

Receive Using the Advanced Shipping Notice (ASN)

Receive ASN Shipments Workform

Set Batch Print Workslips option for ASN Receiving

Receive Using the Advanced Shipping Notice (ASN)

To receive shipments for which an ASN has been received:

Note:
For more information on the ASN, see the Acquisitions PDF Guide,
Receiving Orders.

1. Select Acquisitions > EDI Services > Receive ASN Shipments.
The Receive ASN Shipments workform opens.

2. To change the branch location selected in the Filter By Organization box, select a
different branch or select All.

3. Search for the ASN using one of the following methods:

« Select ASN tracking barcode, and scan the barcode located on the label
attached to the outside of the carton. Or, type the number that displays under
the barcode.

« Select Supplier SAN, and type the supplier's SAN.
« Select ASN date range, and select a from and to date.
4. Click Go.
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The top section of the workform displays the shipment information in the
following columns:

Tracking barcode
Shipped date
Supplier

Carrier

. Select a tracking barcode in the top section of the workform.

The line item information for the selected shipment appears in the bottom section
of the workform in the following columns:

Tracking barcode

Title

Author

ISBN/UPC

Ordered (the quantity ordered)

Shipped (the quantity shipped from the ASN)
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Received/ASN Received (the quantity received)
PO Line ID

Line Status

PO Number

PO Release (date)

Tip:

To link to the purchase order or purchase order line item, select a line
item in the bottom portion of the workform, right-click and select
Links.

6. Click Receive Carton.

The line items are received. The corresponding number of copies are received in
the linked purchase order line item. If the Polaris Administration Acquisitions
profile Receiving line items: Warn if linked hold requests is set to Yes, a message
displays for titles that have hold requests.

Printing Workslips When Receiving ASN Shipments

Note:

The Polaris Administration Acquisitions parameter Batch print workslips
during ASN receiving must be set to Yes to allow the printing of workslips
from the Receive ASN Shipments workform.

After receiving on the Receive ASN Shipments workform, you can print purchase order
line item workslips. If multiple copies of the same title are received in separate cartons,
only one workslip is printed for the title. To print purchase order line item workslips from
the Receive ASN Shipments workform, select File > Print > PO Line ltem Workslips, or
select the down arrow next to the printer icon, and select PO Line Item Workslips.

B =sh rrecamsing
File %iew Help
== 5,
Crrent 'vhew Cidl+P
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ASN and EDI Invoices

If the ASN Shipments option is selectedin the supplier record, the following invoice
processing occurs:

If the order was received via the Receive ASN Shipments workform, the EDI invoice
is created automatically in Polaris from the supplier's EDI invoice file (810).

If the order has not yet been received from the Receive ASN Shipments workform,
the following occurs:

An e-mail is sent with the following message: ASN processing must be done
before EDI Invoice #xxxxxxxx can be created.

The ungenerated EDI invoice file is held in the Process EDI Invoices workform
regardless of the Hold partial shipments setting in the EDI Invoice Defaults profile.

Once the order is received via the ASN, the invoice is created automatically when
the EDIAgent runs again. Or, you generate the invoice from the Process EDI Invoices
workform as long as the order has been received via the ASN.

If Hold partial shipments is selected in the EDI Invoice Defaults profile, and the
quantity ordered does not equal the quantity shipped, the invoice will remain in the
Process EDI Invoices workform until the remainder of the order is received. Then,
the invoice will be created automatically. Or, you can generate the invoice from the
Process EDI Invoice workform.

ASN Reports

The following standard reports are available from the Polaris Shortcut Bar under Utilities
> Reports and Notices > Acquisitions:

« Advanced Shipment Notification Log - The Advanced Shipment Notification log dis-

plays all titles received via ASN for a supplier and line item status date range. To
generate the report, enter the Supplier SAN (with or without the hyphen), the Line
item status start date, the Line item status end date, and click Submit. The line
item status date is the date the line item’s status was updated to Received (all seg-
ments were received via ASN), or Partly Received (some segments were received
via ASN).

The report lists purchase order line items that have segments received via ASN
within the time period (including the start and end dates) for the specified supplier.
It includes the following columns of information sorted by purchase order number,
then title, then carton tracking number: PO # / Suffix; Title / Author / ISBN (UPC);
Tracking Barcode; POLI ID; Ord - Total quantity ordered from the purchase order
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line items; Sent - Total quantity shipped by the supplier; Rec - Total quantity of all
received purchase order line item segments; ASN Rec - Total quantity of purchase
order line item segments received using the Receive ASN Shipments workform;
Note - If the shipped quantity was adjusted, a note appears in this column. The
report is printed in landscape page orientation.

« Advanced Shipment Container Content Report - Lists all items found in a specific
package or container for which the supplier has sent an EDI ASN file. Type or scan
the 18-digit SSCC tracking barcode in the Report Wizard window. The report is sor-
ted by title, and it includes the following information: title; author; ISBN or UPC; pur-
chase order number and suffix; purchase order line item ID; and the total quantity
sent.

« Advanced Shipments Not Yet Received - Lists all items found in a pack-
age/container for which the supplier has produced an ASN, but which has not yet
been received through the ASN workform. To generate the report, enter the sup-
plier's SAN (with or without hyphens) in the Report Wizard dialog box. The report is
sorted by tracking barcode, then PO number, then title. It lists the tracking barcode,
PO#/Suffix, Title/Author/ISBN (UPC), PO Line ID, Qty Sent, and the Date Shipped.

For more information, see the Polaris Basics Guide.

Update on-order item records

When you release a purchase order, you can opt to create on-order item records. These
item records can be updated in the following ways:

« Update items using Item Bulk Change - If your library does not use enriched orders,
you can use the Item Bulk Change dialog box to assign barcodes and call numbers
to the linked on-order items. From the purchase order, select Links > Item Records
to open the linked list box. Then, select the items, right-click and select Ad hoc Bulk
Change from the context menu to access the Item Bulk Change dialog box. See the
Cataloging Guide, Changing Multiple Item Records.

« Update items manually - Select Links > Item Records to open the linked list box.
Open the first item record in the linked list box, scan the barcode and make other
edits. Then, press CTRL+S to save the first record, and press CTRL+E to go to the
next record in the linked list box without leaving the ltem Record workform.

« Automatically receive EDI purchase order line items - When you send orders via EDI,
an EDl invoice file is retrieved from the supplier’s site, and invoice records are cre-
ated automatically in the Polaris database. You can select Update linked purchase
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order line items on the EDI Invoice Defaults profile, and opt to update the linked
on-order items or leave them on-order. See the Acquisitions Administration Guide.

Receiving shelf-ready items - If your library sends “enriched” EDI orders, the supplier
provides bibliographic records with embedded holdings data. When the bib-
liographic records are imported, the embedded holdings data update the on-order
item records with barcodes and other cataloging and circulation information, mak-
ing them shelf-ready. For more information, see Enriched EDI Orders and Shelf-
Ready Items. If you receive shelf-ready items as a result of Enriched EDI, you can
use the Check In Shelf-Ready Materials workform to check in the on-order items
and receive the linked purchase order line item segments. See the Patron Services
Guide.

Receive ASN Shipments Workform

The Receive ASN Shipments workform opens when you select EDI Services, Receive
ASN Shipments from the Acquisitions menu. To use this workform, the ASN
Shipments box must be checked on the Supplier workform. For more information, see
Receive using the Advanced Shipping Notice (ASN).

Use the Receive ASN Shipments workform to receive materials by doing the following:

Select the branch or select All in the Filter By Organization box.
Search for the purchase order line items using one of the following methods:

Select ASN tracking barcode, and scan the barcode located on the label attached
to the outside of the carton. Or, type the number that displays under the barcode.

Select Supplier SAN, and type the supplier's SAN.
Select ASN date range and select a from and to date.
Click Go.

The top section of the workform displays the shipment information.
Select a tracking barcode in the top section of the workform.

The line item information for the selected shipment appears in the bottom section
of the workform.

To link to the purchase order or purchase order line item, select a line item in the
bottom portion of the workform, right-click and select Links.

Click Receive Carton.
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The line items are received. The corresponding number of copies are received in
the linked purchase order line item.

To print purchase order line item workslips from the Receive ASN Shipments workform,
select File > Print > PO Line Iltem Workslips.

Note:

The Polaris Administration Acquisitions parameter PO line item workslips:
Batch print during ASN receiving must be set to Yes to allow the printing
of workslips from the Receive ASN Shipments workform. See Set batch
print workslips option for ASN receiving.

Set batch print workslips option for ASN receiving

Note:
Set this parameter only if your library receives shipments using the
Advanced Shipping Notice (ASN).

To allow or prevent batch printing of purchase order line item workslips from the Receive
ASN Shipments workform.

1. In the Administration Explorer tree view, expand the System folder.
2. Select Parameters > Acquisitions/Serials tab.
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Double-click PO line item workslips: Batch print during ASN receiving.
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Select Yes to allow purchase order line item workslips to be printed in batch from
the Receive ASN Shipments workform.

Select File > Save.
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Receiving Shelf-Ready Items Based on Enriched EDI
Orders

You can create and send enriched EDI orders the same way you create and send
standard EDI orders. The setting in the linked supplier record determines whether the
order is enriched. When you contract with a supplier to provide shelf-ready materials and
set up the supplier record for enriched EDI, the orders include the following information,
which enables the supplier to catalog the shelf-ready materials:

« Unique purchase order line item ID *Quantity for a specific location *Polaris Bib Con-
trol number

« Polaris Destination (location) abbreviation

« Polaris Collection abbreviation Linked on-order item record call number (max 48
characters)

o Purchase order line item segment number

When the supplier receives the enriched EDI order, it processes the order and provides
fully-cataloged MARC records with embedded holdings data in the 949, 948, 852 or any
other tag your library and the supplier have defined.

The following is an example - of MARC record with holdings data in 949 tags:
=LDR 00849njm 22002412a 45x0 =024 1\$a803020113725

=028 428aDUG113725C =035\\$a1021126

=245 10SalLonesome, on'ry and mean: a tributeSh[sound recording].

=260 \\SaNew York, NY :SbDLT Entertainment,$c2003.

=300 \\Sa1 sound disc :Sbdigital ;Sc4 3/4 in. =500 \\SaCompact disc.

=856 7\S3View cover artSuhttp://xxxx.com/images/movies/dug113725c.gif$2http
=949 \\$SSaOUTRSbACASShCD 123 TESTSp31133704160318Se161644-1

=949 \\$$aOUTRSbACASShCD 123 TESTS$p311337041603263e161644-1
=949 \\$$aOUTR$bACASShCD 123 TESTSp31133704160334$e161644-1
=949 \\$$aWSLSbACASShCD 123 TESTS$p311337041603423e161644-2

The library can import the full bibliographic records using an import profile copied from
the Enriched EDI Orders read-only import profile. The Enriched EDI Orders read-only
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import profile is set up to overlay the brief bibliographic records and update the item
records using data in the 949 or other embedded holdings tag.

Tip:
The library can customize the profile, but the import profile values must
match the supplier's tag and subfields.

Sa - Assigned Branch

$b - Collection

Sc - Shelf Location

$d - Statistical Code

Se - PO line item ID -Segment # (matches to the on-order item)
$f - Display in PAC

Sg - Holdable

Sh - Classification #

Si - Cutter Number

§j - Shelving Scheme

Sk - Call Number Prefix
S| - Temporary Shelf Location
Sm - Call Number Suffix
So - Owning Branch

Sp - Barcode

Sq - Physical Condition
Sr- Fine Code

8s - Non Circulating

$t - Copy Number

Su - Loan Period Code
Sv - Volume Number

Sw - Material Type Code
$x - Non Public Note
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Sy - Renewal Limit
Sz - Public Note
S0 - Price

When the shelf-ready materials arrive at the library, a staff member with the Acquisitions
permission, "Check in shelf-ready materials," uses the Check In Shelf-Ready Materials
workform to check the items in via Circulation and receive the items in Acquisitions.

Create and Receive Based on Enriched EDI Orders

Use the information in the following topics to create and receive shelf-ready items based
on enriched EDI Orders.

Enter the Supplier's EDI Ordering Data

Automatic Processes During Import

Enriched EDI Orders and Shelf-Ready ltems

EDI File Sent Warning Message Box

Enter the supplier's EDI ordering data

If the supplier accepts purchase orders via Electronic Data Interchange (EDI) and your
library wants to send orders electronically to this supplier, the supplier record must
contain the correct EDI ordering information. See the Acquisitions Administration Guide
for a list of the information you need to get from the supplier.

Important:

If you are implementing ASN processing with a supplier to whom you have
previously sent EDI orders, before you select the ASN Shipments check
box in the Supplier record, make sure the Hold partial shipment invoices
are created for the day ASN processing will begin by following these steps:

- Ask the supplier the exact date when they will start producing ASN files.

- In the morning of the day the ASN processing will begin, wait until the
Polaris EDIAgent has run and all remaining EDI invoices for that supplier
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have been created automatically. If your library does not process partial
EDI invoices separately (the Hold partial shipments box is unchecked in
the EDI Invoice Defaults profile) go to Step 4 of the procedure below.

- If the Hold partial shipment box is checked in the EDI Invoice

Defaults profile for your library organization, go to the Process EDI Invoice
workform as soon as the EDIAgent runs, and create the invoices for this
supplier. See Process EDI invoices for partial shipments.

To enter information for a supplier that accepts EDI orders:

. Open the Supplier workform.
. Select the EDI orders check box.

. The other selections in the Communications frame are active when you select the
EDI orders check box, and the required fields are in bold type.

45 Mew Supphar Recard - 1 - Genaral - Polaric =1 @ =
Fil Edit Wimw Links Tooih Halp
FHSs- E7
Fiame]  EDL Suppiar| ARt e e Curency! LD oo
AL f Aot Demer |omrmurty Libery (Coblesd] iTon) -
Enouméeancs Lmik Eoarchirg Lomds
Lina ! 00 Supplier $01.00 L | B2 g1.00 - Supplior §0.00
Crcier: $1.00  Tow: 000 Irvasice: $.00  Tow: 000

i acomim [Feiordan TEnviched B0 crders ] A Shomanis aikass v ofs (D & dczouni @ SAREAH S
| FTP addesa POASNY direciony

| Userrame: P dirpobory:
Pozmened: P Tl extwnsion

Fow Help, peass FL Hilkd

Important:
If you select EDI orders, you cannot save the Supplier record without

the supplier's seven-digit standard address number (SAN) in the
SAN box. See the Acquisitions Guide, Create a new supplier record.
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Select one of the following options, if applicable:

« If your library and the supplier have an agreement whereby the supplier
provides shelf-ready cataloging services, select the Enriched EDI orders
check box.

Note:

Enriched EDI includes cataloging services offered by the vendor,
such as branch stickers on books and other materials, fully-
cataloged MARC records, and 852 or 949 tags in the bibliographic
records that automatically create item records. The type of services
and the costs vary according to vendor. For more information, see
Enriched EDI Orders and Shelf-Ready Items.

« If the supplier provides an advanced shipping notice, select ASN Shipments.

Note:

If the ASN Shipments box is checked, EDI invoices are not created
automatically. See Receive using the Advanced Shipping Notice
ASN).

Select Account # or SAN/SAN Suffix to indicate the address or profile ID. Your
Polaris Site Manager will confirm this information.

Type the FTP address in the FTP Address box.
Type the File Transfer Protocol (FTP) username in the Username box.
Type the FTP password in the Password box.

Note:
The password does not appear when you type it.

Type the directory for the purchase order acknowledgment and invoice in the
POA/INV directory box.

Type the directory for the purchase order in the PO directory box.
Type the file extension for the purchase order in the PO file extension box.
Select File > Save.
Related Information
Setting up EDI ordering - To communicate with a supplier via EDI, you must first

contact the vendor and get specific information to enter in Polaris. See the Acquis-
itions Administration Guide.
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Polaris EDIAgent - The Polaris EDIAgent is an SQL job that scans the supplier's FTP
server for files in the library’s directory, retrieves the files, and saves them in the
Polaris database. For more information, see the Acquisitions Administration Guide.

Sending an EDI order - See Transmit a purchase order electronically.

Sending enriched EDI orders and receiving shelf-ready items overview - See
Enriched EDI Orders and Shelf-Ready ltems.

Electronic Purchase Order Acknowledgment - You can generate the Electronic
Purchase Order Acknowledgment from the Utilities menu. See the Polaris Basics
Guide.

Receiving the EDI invoice - The EDI invoice is created automatically in Polaris from
the supplier's EDI invoice data. For more information, see Review automatic EDI
invoices.

Receiving via the Advanced Shipping Notice (ASN) - See Receive using the
Advanced Shipping Notice (ASN).

Automatic Processes During Import

When records are imported, they are processed according to settings in the import profile
and in Polaris Administration. Some processing takes place before any records are
created or updated, and other processing occurs when the data in the imported records
are used to create or update records. This section covers the automatic processing you
can choose to initiate in the import profile settings.

See also:

MARC Records Validated
Authority Control Performed

Records Checked for Duplicates

Specific MARC Tags Removed from Incoming Bibs

Incoming Bibs Protected from Being Overlaid

Bib Tags Marked to Prevent Creation/Updates of ltems
Authority Records Deleted
ltem Records Created from Embedded Holdings Tags

Bibliographic Overlay Based on Encoding Level
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« Specific MARC Tags Removed from Incoming Bibs

« Authority Record Overlay Based on Cataloging Source

MARC Records Validated

If validation is selected in the import profile, the records are validated according to the
following Polaris Administration Cataloging profiles: MARC validation:

Bibliographic and MARC validation: Authority. However, if the incoming records contain
indicators or subfields with data that cannot be validated, the data is replaced with the
following defaults: Indicators default to ' ' and subfields default to '?'. For more
information, see the Cataloging Administration PDF Guide, Administering MARC
Validation and Display.

Authority Control Performed

If the options to Perform authority control and Automatically create new authority
record; save bibliographic record as final are selected in the Bibliographic Records tab
of the import profile, the system searches for an existing authority record for the
heading. If no matching authority record is found in the local database, an authority
record is created automatically and saved to the database. If your library has a
subscription to a remote database of authority records, the remote database is
automatically searched when no matching authority record is found. The new authority
record is saved in the database and linked to the new bibliographic records. Search
Polaris help for "Set import options for authority records."

Records Checked for Duplicates

If duplicate detection is selected in the profile, duplicates are identified according to the
rules in the following Polaris Administration database tables: Bibliographic
Deduplicaton or Authority Deduplication. For more information, see Cataloging
Administration PDF Guide. Change bibliographic or authority deduplication tables. You
can also select the option Use profile defined duplicate detection rules in the import
profile and select the rules to apply.

Specific MARC Tags Removed from Incoming Bibs

If the import profile is set up to automatically remove tags from incoming bibliographic
records, the tags are removed from the records before they are saved in the Polaris
database. Search Polaris help for "Set import options for bibliographic records."
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Incoming Bibs Protected from Being Overlaid

If the import profile is set up to check the Do not overlay box on the incoming records,
they are saved as protected records that cannot be overlaid. Search Polaris help for "Set
import options for bibliographic records."

Bib Tags Marked to Prevent Creation/Updates of Items

If you are using an import profile that is set to create item records from embedded
holdings tags, an automatic process first checks the bibliographic records for the
presence of pre-existing holdings tags with the same tag number specified in the import
profile. If pre-existing tags are found that match the retained tags under Keep MARC
tags in the import profile, and these tags do not already have a $9 subfield, then a
system-supplied $9 with the text Tag retained from duplicate overlay is inserted into the
tag. Pre-existing embedded holdings tags that do not already have a $9 subfield are
marked automatically without a Polaris Administration parameter.

When embedded holdings tags are used to create new items or to update on-order items
to shelf-ready items, a $9 with the text Item generated is inserted into the tag if the
Polaris Administration Cataloging parameter MARC embedded holdings tags as
processed is set to Yes. During the import process, item records are not created or
updated if the embedded holdings tags are marked as follows:

« $9 Tag retained from duplicate overlaymmm dd yyyy hh:mm[AM/PM]
Or
« 89 Item generated mmm dd yyyy hh:mm[AM/PM]

Your Polaris Administrator can use a utility to automatically scan for specific tags
marked with §9 and remove them. See the Cataloging Administration PDF Guide, Setting
Utility to Delete Bib Tags Marked with Subfield 9.

Authority Records Deleted

If the incoming authority record status (Leader/05) is d, s, or x, the following deletion
processing occurs during import:

« If the incoming authority record status is d (deleted), the following processing
occurs:

« All bibliographic record links to and from the existing authority record are dis-
connected.

© 2020 Innovative Interfaces, Inc.
Page 72



Automated Acquisitions Guide

« If any authority record has the existing authority record 1xx field as a 4xx field, the
cross-reference is logged in the import report.

« All authority record links to the existing authority record are disconnected.
« The existing authority record is replaced by the incoming record.

« The deleted record is logged in the import report.
« If the incoming authority record status (Leader/05) is s (deleted; heading split into

two or more headings), the following processing occurs:

« All bibliographic and authority record links to and from the existing authority record
are disconnected.

« All disconnected links are logged in the import report.
« The existing authority record is replaced by the incoming record.
« The deleted record is logged in the import report.
« If the incoming authority record status (Leader/05) is x (deleted; heading replaced

by another heading), the following processing occurs:
« All bibliographic and authority record links to and from the existing authority record

are disconnected.

« The existing authority record is replaced by the incoming record.
o The deleted record is logged in the import report.

Item Records Created from Embedded Holdings Tags

When you import bibliographic records using an import profile that is set to build item
records from embedded holdings tags, the items are created automatically based on the
holdings tag number and MARC subfield mapping specified on the ltem Records tab.
This table shows the default settings, requirements, and data entry conventions for item
record creation from data in the 852 tag in the Polaris default (with item creation)
profile. The data entry conventions apply to all profiles.

Polaris Item
Record Field

Subfield Required

Data Entry Con-

ventions

Assigned Sa Yes Must match a

(branch) branch ID or
abbreviation. 15
characters max.

Collection Sb No Must match a
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Polaris Item
Record Field

Subfield

Required

Data Entry Con-
ventions

collection ID or
abbreviation. 15
characters max.

Barcode

Sp

No

20 characters
max.

Call Number
Prefix

Sk

No

60 characters
max.

Call Number
Suffix

Sm

No

60 characters
max.

Circ Status

N/A

No

ID or description.
80 characters
max. Certain circ
statuses are not
allowed in new
item records, for
example Lost. If
the ID or
description in the
circ status is not
allowed, the circ
status is taken
from the template
or from system
defaults for item
records.

Classification
Number

$h

No

60 characters
max.

Copy Number

St

No

60 characters
max.

Cutter Number

Si

No

60 characters
max.
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Polaris Item . . Data Entry Con-

Record Field Subfield Required ventions
Display in PAC S4 Yes 0=No,1=Yes
Fine code Sr Yes FineCodelD (ID or

description). 80
characters max.

Free Text Block N/A No 255 characters
max.

Funding Source S1 No 50 characters
max.

Holdable S5 Yes 0=No, 1=Yes

Library Assigned | N/A No ID or description.

Block 80 characters
max.

Loan Period Code | Su Yes LoanPeriodCodelD,

ID or description.
80 characters

max.

Loanable Outside | $7 Yes 0=No,1=Yes

System

Material Type Sw Yes MaterialTypelD ID,
or description. 80
characters max.

Name of Piece N/A No 255 characters
max.

Non Circulating N/A No 0=No, 1=Yes

Non-Public Note | Sx No 255 characters
max.

Owner (branch) So Yes Must match a
branch ID or

abbreviation. 15
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Polaris Item Subfield ReanEY Data Entry Con-

Record Field ventions

characters max.

Physical Sq No 255 characters
Condition max.
POLI-SegmentID | N/A No Number

Price S0 No Monetary value

(Format: ##.## No
'S' should be in the
subfield; a decimal
should be included
where
appropriate.)

Public Note Sz No 255 characters
max.

Renewal Limit Sy Yes 0-99

Shelf Location Sc No Must match shelf
location ID or
description. 80
characters max.

Shelving Scheme | §j Yes 0=No information,

2=Library of
Congress

3=Dewey Decimal

4=National Library
of Medicine

5=Superintendent
of Documents

6=Shelving Control
Number

7=Title
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Polaris Item . . Data Entry Con-
Record Field Subfield Required ventions
8=Shelved
Separately
9=0ther
Statistical Code Sd No ID or description.
80 characters max
Temporary Shelf | Sl No 25 characters
Location
Vol (volume) Sv No 60 characters
max.

Duplicate Records Overlaid

If the import profile is set to perform duplicate detection, it can also specify how
duplicate records are handled. For information regarding the process that compares the
encoding level of duplicate bibliographic records, see Bibliographic Overlay Based on
Encoding Level. For information regarding the process that compares the cataloging
source of duplicate authority records, see Authority Record Overlay Based on Cataloging

Source.

Tags Retained from Duplicate Records

The Bibliographic Tags to Retain/Delete policy table is used to identify tags in
bibliographic records to retain from duplicate records that are overlaid. The Authority
Overlay Retention policy table is used to identify tags to retain from duplicate records
that are overlaid.

Note:

The Bibliographic Tags to Retain/Delete policy table can also be used to
identify tags to delete from incoming records whether they are duplicates
or not.

© 2020 Innovative Interfaces, Inc.
Page 77



Automated Acquisitions Guide

For more information on these tables, see the Cataloging Administration PDF Guide,
Specify tags to retain from overlaid bibs.. For bibliographic records, you can also select
the option Profile-defined overlay retention tags in the import profile and select
additional bibliographic tags to retain. Search Polaris help for "Set import options for
bibliographic records."

Bibliographic Overlay Based on Encoding Level

If the import profile is set to compare the encoding levels of duplicate records, the value
in Leader position 17 is checked.

Note:
Double-click on the Leader in the MARC21 view of the Bibliographic
Record workform to see the encoding levels in Leader position 17:

space - Full level

1 - Full level, material not examined

2 - Less than full level, material not examined
3 - Abbreviated level

4 - Core level

5 - Partial (preliminary) level

7 - Minimal level

8 - Prepublication level

E - System-identified MARC error in batchloaded record
| - Full-level input by OCLC participants

J - Deleted record

K - Less-than-full input by OCLC participants

L - Full-level input added from a batch process
M - Less-than-full added from a batch process
u - Unknown

Z - Not applicable

The following table shows the values in the incoming record in Leader position 17 and
the values in the existing record that allow or disallow an overlay. If the encoding levels
are equal, the records are processed according to the setting in the import profile.
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Incoming LDR/17 Value Can Overlay Cannot Overlay

space space J

1

2
3
4
5
7
8

L

M

Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
1 1 space
2 I
3 L
4 J
5
7
8
u
z
E
K
M
Incoming LDR/17 Value Can Overlay Cannot Overlay
2 2 space
3 1
4 7
5 I
8 L
u J
z
E
K
M
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Incoming LDR/17 Value Can Overlay Cannot Overlay
Incoming LDR/17 Value Can Overlay Cannot Overlay
3 3 space
5 1
8 2
u 4
z 7
E I
J
K
L
M
Incoming LDR/17 Value Can Overlay Cannot Overlay
4 3 space
4 1
5 7
8 I
u J
z K
E L
M
Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
5 5 space
u 1
z 2
E 3
4
7
8
I
J
K
L
M
Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
7 2 space
3 1
4 I
5 J
7 L
8
u
z
E
K
M
Incoming LDR/17 Value Can Overlay Cannot Overlay
8 5 space
8 1
u 2
z 3
E 4
7
I
J
K
L
M
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Incoming LDR/17 Value Can Overlay Cannot Overlay
u u space
z 1
E 2
3
4
5
7
8
I
J
K
L
M
Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
z u u
z space
E 1
2
3
4
5
7
8
I
J
K
L
M
Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
E E u

z

space

0 I N|[lo ||| N

r| X | «

M

Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay

I space J

1

2
3
4
5
7
8

L

M

Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay

J space

1

O (I N[ || W [N

—r | X | &«

M

Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
K 2 space
3 1
4 7
5 I
8 J
u L
z
E
K
M
Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay

L space J

1

2
3
4
5
7
8

L

M

Incoming LDR/17 Value Can Overlay Cannot Overlay
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Incoming LDR/17 Value Can Overlay Cannot Overlay
M 2 space
3 1
4 7
5 I
8 J
u L
z
E
K
M

Authority Record Overlay Based on Cataloging Source

If the option Merge duplicate records is selected when importing authority records, the
040 Sa of the incoming record is checked against the entries in the following
Administration policy table: Authority Record Import: Preferred Cataloging Source. If
the (040 Sa) code in the incoming record matches an entry in the table, the preference
order of the code is checked. The incoming record overlays the database record if it has
a higher level of preference than the code in the database record.

Note:

For information on setting up this policy table, see Cataloging
Administration PDF Guide, Specify preferred cataloging sources for
authority records.

1. The original cataloging agency of the incoming record (tag 040 Sa) is matched to
entries in the Authority Record Import: Preferred Cataloging Source policy table in
Polaris Administration.
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Preferred Cataloging
Source Table Entries for
Importing Library

Incoming Record Tag 040

Import Processing Status

Sa

Valid for import

Has entries Matches a table entry .
processing

Invalid record is logged in
. D not match | ) .
Has entries oes not match a table the import report, but is

entry not added to the catalog

Invalid record is logged in
Has entries No tag 040 the import report, but is
not added to the catalog

Incoming record is added
to catalog as provisional.
Logged in import report.
No entries No tag 040 Added to provisional
record set if specified.
Existing record is not

changed.
, Has original catalogi i i
NG entries g : ging Valid for import
source information processing

2. If theimported authority record is from a preferred cataloging agency, the ranking
of the agency is compared with the agency ranking of the existing record.

The ranking of preferred cataloging agencies is determined by the agency’s entry
position in the Authority Record Import: Preferred Cataloging Source policy table in
Polaris Administration.

Incoming Record Original Cata- Processing Done for Incoming

loging Agency Preference Record
Higher than the agency forthe | Processed according to value
existing record in record status (Leader/05)
Equal to the agency for the Processed according to value
existing record in record status (Leader/05)
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Incoming Record Original Cata- Processing Done for Incoming

loging Agency Preference Record

Existing record does not have Processed according to value
a cataloging agency specified in record status (Leader/05)

Entry logged in import report.
Incoming record is not added
to catalog.

Lower than the agency for the
existing record

3. If theimported record has a higher or equal source preference than the existing
record, the duplicate records are processed based on the record status (Leader/05)
of the incoming record.

« If the incoming record has a record status of n (new), ¢ (corrected or revised), or a
(increase in encoding level), Polaris does new or update processing.

« If the incoming record has a record status of d (deleted), s (deleted with heading
split), or x (deleted with heading replaced), Polaris does deletion processing.

Importing and Ordering Processes

Automatic processing during importing and ordering work together in Polaris to create
purchase orders or selections lists, and update on-order items so they can circulate.

See also:
« The Bulk Add Process
« Enriched EDI Orders and Shelf-Ready ltems

The Bulk Add Process

When you import a supplier’s brief bibliographic records using the Acquisition Bibs
import profile (or a copy of this profile), the records are gathered in the bibliographic
record set specified in the profile. Then, you open the record set and bulk-add the records
to create a purchase order or a selection list. Specific tags and subfields must be in the
imported bibliographic records for Polaris to create the line items and segments.

Important:
The import profile must be set up to retain 970 tags as well as 020 (ISBN)
and 024 (UPC) tags. See the Cataloging Guide.
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The following information in the 970 tag of the bibliographic record is used to create
each segment of the purchase order or selection list automatically:

Note:

The collection information, material type, and non-public note are not
required to create a segment. If the supplier includes copy-level
information in $h, it is used in the creation of on-order items.

Tip:

The subfields can be in any order in the 970 tag.
8l = location (must match the branch abbreviation in Polaris)
$q = quantity

$f = fund (must match the fund name or fund alternative name for an open fund in
Polaris)

Sc = collection (must match the collection abbreviation in Polaris)
Sp = price
$m = material type (must match the material type code in Polaris)

$n = non-public note (cannot exceed 255 characters; if there is a non-public note, it
appears on the Instructions to Supplier view of the Purchase Order Line ltem work-
form)

Sh = item template code. It can contain alpha and/or numeric characters, or up to
10 characters. See the Acquisitions Guide, Creating On-Order Item Templates.

The illustration shows how the 970 tags in the bulk added bibliographic record are used
to create purchase order line item segments.

T Ficchsin Crr Linm B - 19745 - G - Pl e |
Pl Bl wic tinte T ook Haip
| D-w@e-x F % &

T B s i Pueoorad 879190 - FARECIE - Blnie
Fiy Ede ies b Tack Mk o oo 1w -

0w & R A &

Dmscrivion

k8 2 | Purchase Order Line Ttem

If a bulk-added bibliographic record contains more than one ISBN or UPC, the purchase
order line item displays the most-recently added ISBN (020S$a) at the top of the ISBN list
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(and its associated price from the 020Sc in the Price box), or the most-recently added
UPC in the Other number box.

Note:

If the Polaris Administration Acquisitions parameter Bulk add to PO: Add
Alert to PO line item for multiple ISBNs is set to Yes, purchase order line
items with multiple ISBNs are listed with an exclamation mark in the Find
Tool results list and the Purchase Order workform, Line Items view. The
Alert box is also checked in the Purchase Order Line ltem workform if the
linked bibliographic record contains multiple ISBNs.

If a price is not in the MARC record’s 970 Sp, the system checks for the price in the
following tags:

« 020-If an ISBN is present in 020 $a, the corresponding 020 Sc is checked for a
price. If both are found, the ISBN is copied to the purchase order line item’s ISBN
field, and the price is copied to the purchase order line item’s Unit price field.

o 024 -If no price is found in the 020 $c, the system checks for a 024 Sa with a first
indicator of 3, and if present, the corresponding 024 Sc is checked for a price
(OCLC records place the 13-digit ISBN and the accompanying price in the 024 tag,
if the first indicator is a 3). If both are found, the number in the 024 $a is copied to
the purchase order line item’s ISBN field, and the price is copied to the purchase
order line item’s Unit price field.

Note:

If the first indicator in the 024 Sa is 1 or any number other than 3, the
number is copied to the purchase order line item’s Other number field. In
this case, the unit price is copied from the default value in the Bulk Add to
Purchase Order dialog.

If the price is not in the record, and the Acquisitions parameter Bulk Add to PO: Replace
Invalid Fields with Default Data is set to Yes in Polaris Administration, the default price
is used.

Any missing or invalid information is noted in the bulk add error report, and you can edit
the purchase order or selection list as needed.

Administration Settings That Affect Bulk-Add Processing

The following parameters and profiles in Polaris Administration control bulk-add
processing:

© 2020 Innovative Interfaces, Inc.
Page 95



Automated Acquisitions Guide

« Bulk add to PO: Add Alert to PO line item for multiple ISBNs - Adds an alert for pur-
chase order line items with multiple ISBNs.

« Bulk add to PO: Replace invalid fields with default data - Specifies defaults for
records bulk-added to purchase orders.

« Bulk Add to SL: Replace invalid fields with default data - Specifies default data for
records bulk-added to selection lists.

« Bulk add to PO/SL: Mark 970 data as processed - Marks processed 970 tags so
they do not get used again.

« Filter branches in line item segments - Filters destination branches.

For more information, see the Acquisitions Administration Guide.

Enriched EDI Orders and Shelf-Ready Items

If your library uses a supplier's cataloging services so that materials arrive shelf-ready,
you can send enriched EDI orders so that the supplier can return bibliographic records
with embedded holdings data. When the bibliographic records are imported using the
Enriched EDI Order import profile, the embedded holdings data is used to update on-order
items to shelf-ready items. Another method for creating shelf-ready items is to allow the
supplier to search the Polaris database and retrieve holdings information. See Shelf-
Ready Items Using Z239.50.

Enriched EDI Orders

An Enriched EDI order includes the following information for each purchase order line
item segment in the transmission:

o Title

« ISBN

« Bibliographic record control number (from Polaris)

« Purchase Order Line Item ID - Unique ID for the purchase order line item, not the
number that appears in the Purchase Order workform

o Purchase Order Line Item Segment Number - Segment number as it is displayed in
the Purchase Order Line Item

« Quantity - Number of copies ordered for that location (collection and branch)
« Branch Code - The branch’s abbreviation exactly as defined in Polaris
« Collection Code - The collection abbreviation exactly as defined in Polaris
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« Call Number - Call number in the linked on-order item record. Your supplier may or
may not use call numbers.

When the supplier processes the Enriched EDI order, a file containing full bibliographic
records with embedded holdings data is produced. These bibliographic records with
embedded holdings data in the 949 tag (or another tag you and your supplier have
agreed upon) are imported into Polaris. If the holdings data is in the 949 tag, you can
use the Enriched EDI Order profile (or a copy of the profile with the same settings, but
named according to the supplier) to import these records. This profile is set up so that
the existing item records are updated with the data in the 949 tag.. See the Cataloging
Guide.

If the option Update linked PO line item to received is checked in the EDI Invoice
Defaults profile, the linked purchase order line items are received, and the linked items
either remain on-order, or they are updated to in-process as soon as the EDI invoice is
created in Polaris (depending on the item record option selected in the profile). See the
Acquisitions Administration Guide.

You can wait until the shipment arrives to update the purchase order line items. When
the shipment arrives, use the Check In Shelf-Ready Materials workform to check in the
shelf-ready item records and update the linked purchase order line item segments in the
same step. See the Patron Services Guide.

Shelf-Ready Items Using Z39.50

If your library allows suppliers to search the Polaris database using Z39.50, the supplier
can provide shelf-ready item data in their bibliographic records. When the supplier
searches the Polaris database, the bibliographic records are displayed with an 852 tag
for every item record, whether it was manually created or imported. If the item is linked to
a purchase order line item, the holdings data displays the linked purchase order line item
ID followed by the purchase order line item segment number in subfield e (Se). For
information on setting up Polaris as a remote database for suppliers to search, see the
Administration Guide.

See also:

« Patron Services Administration Guide
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EDI File Sent Warning Message Box

The EDI File Sent Warning message appears when you select File, Send, and the
purchase order was already transmitted via EDI.

Use the EDI File Sent Warning message box to:

« Retransmit the purchase order via EDI - Click Continue.
« Cancel the EDI transmission - Click Cancel.
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Processing EDI Invoices

If you send orders using electronic data interchange (EDI), an electronic invoice file is
created automatically when the order is filled. The electronic invoice file is sent to your
library’s out directory on the supplier's FTP server. The EDIAgent retrieves the invoice file
and loads it into the Polaris database.

This process creates an invoice with the suffix EDI. An EDI invoice log with the invoice
results is also created in Polaris and emailed to the address specified in the EDI Invoice
Defaults profile.

In the following cases, the EDI invoice file from the supplier does not create the EDI
invoice in Polaris immediately:

« If Hold partial shipment invoices is selected in the EDI Invoice Defaults profile in
Polaris Administration, invoices are not created automatically. With this setting,
Polaris will not create an invoice from the supplier's invoice data if the quantity
sent does not match the quantity ordered for any line item. See Process EDI
invoices for partial shipments.

« If the ASN Shipment option is selected in the Supplier Record workform, the EDI
invoice is not created automatically until the order has been received via the
Receive ASN Shipments workform.

When the EDI invoice is created, the invoice line items are automatically linked to a
matching purchase order line item. You have the following choices when marking
purchase order line items as received:

1. You can set the EDI Invoice Defaults profile to update the linked purchase order
line item to received as soon as the invoice is saved in the Polaris database. You
can also update the item records.

2. You can choose to wait and update the purchase order line item only when the
physical shipment arrives.

Invoice to Purchase Order Errors

You see a red exclamation point beside the invoice line item in the Find Tool results list
and in the Line Items view of the Invoice workform if the following happens:
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« Polaris does not find a matching purchase order line item

« The matching purchase order line item has an incorrect status, such as canceled.
In this case, the purchase order line item is not linked, but it is used to create an
invoice line item.

Check the invoice log if you see the exclamation point. If a matching purchase order line
item has an incorrect status, the invoice line item is created, and an error is listed in the
log.

See Also
For more information on processing EDI invoices, see the following topics:

Review automatic EDI invoices

Process EDI Invoices Workform

Process EDI Invoices for Partial Shipments

EDI Invoice Default Dialog Box

Review automatic EDI invoices

EDI invoices are created automatically in Polaris using data retrieved from the supplier's
FTP server, and an email message notifies you that the invoice is available. You can
search for EDI invoices by the invoice number suffix EDI.

When an EDI invoice is generated in Polaris, a log of the invoice creation is posted to an
EDI invoice log. The log lists the invoice numbers, and includes whether one or more
titles have holds. The log also lists any errors.

For more information about the invoice log contents, see The EDI Invoice E-mail Log.

Important:

To deal separately with EDI invoices where the quantity sent does not
equal the quantity ordered, select the Hold partial shipment invoices
option on the EDI Invoice Defaults profile. Then you can generate them
using the Process EDI Invoices workform. See Process EDI invoices for
partial shipments. Also see "Set up EDI invoice defaults" in the
Acquisitions Administration Guide.

To open and review automatic EDI invoices:
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1. Select Acquisitions > Invoices from the Polaris Shortcut Bar.
The Find Tool appears with Invoices selected in the Object box.

2. Select Invoice number suffix in the Search by box, and type EDI in the For box.

Note:

You can also limit by the invoice number suffix, EDI. For example,
you can search by invoice date range and limit by the EDI suffix. You
can select a sort by option to sort the results list before it appears.
For example, you could search by the number suffix EDI, limit by
supplier, type Baker*, and sort by owner to list the Baker & Taylor EDI
invoices sorted by the owning branch.

The automatically-created EDI invoices appear in the results.

4] Tevrscm - Irvmicn drie Find Tood = [ ]
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3. Double-click to open the invoice in the Invoice workform.

The EDI filename and the date the order was shipped are displayed in the workform
(if the supplier includes this information).
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4. Select View > Line Items to see the line items in the invoice.

Note:

If there are invoice line items with errors that prevented them from
linking to purchase order line items, a red exclamation point icon
appears next to the invoice line items. The icon also appears in the
Find Tool results list for EDI invoice line items that have errors.
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5. Check your e-mail for messages regarding EDI invoice transmissions. The email
message is a detailed log of the invoices that the EDIAgent picked up from the
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supplier's site. The log lists any bibliographic-level holds placed on the items, and
any errors in the invoice. See The EDI Invoice Email Log.

Important:
Correct any errors before paying the invoice.

. If aninvoice line item is listed with a red exclamation point because it was not
linked to a purchase order line item, you can manually link to the purchase order
line item by doing the following steps:

a. On the Invoice Line Iltem workform, select View > Additional Information.
The Additional Information view appears.

b. Click Find.
The Find Tool appears with Purchase Order Line Item selected.

c. Search for and select the appropriate purchase order line item.

Any information in the Invoice Line ltem workform is overwritten with the
information from the purchase order line item you selected.

Related Information

Setting up EDI ordering - To communicate with a supplier via EDI, you must first
contact the supplier and get specific information to enter in Polaris. See the Acquis-
itions Administration Guide.

Entering EDI information in the Supplier record - Set up the supplier record with the
information you gathered from the supplier. See Enter the supplier's EDI ordering
data.

Polaris EDIAgent - The Polaris EDIAgent is an SQL job that scans the library’s dir-
ectory on the supplier's FTP server. When it finds files, they are retrieved and used
to create the purchase order acknowledgment and EDI invoice. If the supplier
provides an Advanced Shipping Notice (ASN), it is also retrieved by the EDIAgent.
See the Acquisitions Administration Guide.

Electronic Purchase Order Acknowledgment - After the supplier receives the EDI pur-
chase order, an electronic purchase order acknowledgment is placed on the sup-
plier's FTP server. The Polaris EDIAgent retrieves the file and saves it in a local
directory. You can generate the Electronic Purchase Order Acknowledgment from
the Utilities menu. See the Polaris Basics Guide.

Processing partial shipment EDI invoices - If your library has selected the Hold par-
tial shipment invoices option in the EDI Invoice defaults profile, you can generate
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EDI invoices with invoice line items where the quantity sent does not match the
quantity ordered. See Process EDI invoices for partial shipments.

Process EDI Invoices Workform

You can access the Process EDI Invoices workform by selecting EDI Services, Process
EDI invoices from the Acquisitions menu, pressing Alt A +E or by clicking the EDI icon in
the Acquisitions toolbar.

Use the Process EDI Invoices workform to display and process EDI invoices where the
number of items sent is not equal to the number of items ordered.

Note:

Invoices appear on this workform only when the Hold partial receipt
invoices check box is checked in the EDI Invoice Defaults profile. This
setting prevents EDI invoices from being created automatically if any of
the line items in the invoice has an number of copies that is not equal to
the number of copies ordered. EDI invoices are generated automatically if
the number of copies ordered and the number of copies received match
for all titles on the invoice.

« Enter the search criteria for the invoices:
o Enter the invoice number (maximum of 30 characters)
o Enter the supplier's SAN
o Enter an invoice date range by selecting dates in the From and To boxes.

« Filter by organization - If you want to process only a specific organization’s
invoices, select the organization. Set the organization filter to All to see all unpro-
cessed partial EDI invoices.

« Find the partial EDI invoices - Click Go.

« Generate the invoices -Select an invoice, right click and select Generate invoice or
click the toolbar icon.

The invoice is generated. If the Update linked PO line items check box is checked in the
EDI Invoice Defaults profile in Polaris Administration, the linked purchase order line items
are updated to Received, and any segments that could not be received are set to On-
order. If the Update linked PO line items check box is not checked in the EDI Invoice
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Defaults profile, the purchase order line items remain unreceived. You can link to the
purchase order and receive the line items, or you can receive from the invoice.

Process EDI invoices for partial shipments

Use the Process EDI Invoices workform if your library has selected the Hold partial
shipment invoices option in the EDI Invoice Defaults profile in Polaris Administration.
When the option to hold partial shipments is selected, the raw EDI invoice data from the
supplier does not automatically create EDI invoice records in Polaris if the quantity sent
and the quantity ordered do not match for at least one title on the invoice. If all
quantities sent match all quantities ordered for all titles, the supplier's EDI invoice data is
saved automatically as an EDI invoice record in Polaris.

Note:
You must have the permission Process EDI Invoices: Allow set at the
system level to select EDI invoices to process.

To generate an EDI invoice where the quantities sent do not equal the quantities ordered:

Tip:

You can wait to process partial shipment invoices if the supplier indicates
the remainder of the order will be shipped eventually. When the supplier is
able to complete the order and sends the EDI invoice file, the completed
EDI invoice is created automatically in Polaris.

1. Select Acquisitions > EDI Services > Process EDI Invoices from the Polaris Short-
cut Bar, click , or press ALT+A+E.

The Process EDI Invoices workform appears.
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. Enter the search criteria for the invoice as follows:

« Enter the invoice number (maximum of 30 characters).

« Enter the supplier's SAN (maximum of 7 characters).

« Enter an invoice date range by selecting dates in the From and To boxes.

. Tofilter the invoices by branch, select a branch in the Organization box. Select All
to see all partially received EDI invoices in your library system.

. Click Go.
The ungenerated invoice or invoices that meet your search criteria are listed.

. To see the purchase order line items linked to this invoice, right-click an invoice in
the list, and select Purchase Order Line Items from the context menu.

A box lists the linked purchase order line items. At least one of the purchase order
line items listed has a number of copies sent less than the number of copies
ordered. You can open a purchase order line item in its workform by double-
clicking on it.
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Note:
If the invoice is linked to only one purchase order line item, the
Purchase Order Line ltem workform appears.

6. Select the invoice or invoices in the list, right-click and select Generate selected
invoices.

The invoices you selected are generated, and they no longer appear in the list. If the
Update linked PO line items check box is checked in the EDI Invoice Defaults
profile in Polaris Administration, the linked purchase order line items are updated
to Received, and any segments that could not be received are set to On-Order. The
linked item records are either updated to in-process or remain on-order, depending
on the setting in the profile. If the Update linked PO line items check box is not
checked, the purchase order line items remain unreceived. See the Acquisitions
Administration Guide.

7. Use the Find Tool to search for and select the generated EDI invoice.

If the line items are not received automatically, you can receive them from the
invoice or purchase order. See the Acquisitions Guide, Receiving Orders.

Partial Shipments

If you hold EDI invoices for partial shipments, you can set up your distribution
profiles at your supplier’s site so the 970 tags are created first for the branches
where you need the full number of copies ordered. Then you can receive the full
number of copies for the busiest branches and split receipt for branches that can
wait for the full number of copies to arrive. For more information, see the
Acquisitions Guide, Creating Purchase Orders .

The EDI Invoice Email Log

Tip:

The EDIAgent and EDIFTP logs are created automatically, but are not
sent to library staff members. These logs provide information
regarding the FTP transfer and can be used in troubleshooting
connection failures. For more information, see the Acquisitions
Administration Guide.

When Polaris attempts to create EDI invoices from data retrieved from suppliers, a
separate log file is created for each supplier's invoice data. For each invoice, the
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log file indicates whether the invoice was created and lists details regarding any
line items that had errors. These log files are saved in the same directory as the
EDINew and EDIDone folders with the following name:
EDlInvoiceResults_(Supplier name).(Org abbreviation).log.

Examples:
EDlInvoiceResults_Baker_And_Taylor.STl.log
EDlInvoiceResults_Ingram.STl.log.

These logs are emailed to the addresses in the EDI Invoice Defaults profile with the
subject line EDlInvoiceResults and organization abbreviation. The email log lists
invoice line items that were generated, line items with errors, and line items with
bibliographic-level holds placed on the titles.

The following types of messages may appear in the email log that is sent to the
addresses in the EDI Invoice Defaults profile with the subject line EDlInvoiceResults:

« This message indicates the invoices were created successfully and some line
items have linked bibliographic hold requests:

Tip:

The holds information in the log can help you prioritize the processing of
materials that have holds if you have enabled the Update linked PO lines
to Received setting in the EDI Invoice Defaults profile. (When the purchase
order line items are received automatically, users do not see the message
that appears when manually receiving line items with holds.)

Begin processing EDI 810 file: testsal3644d.txt

Invoice # BTSAL3644e Suffix = EDI, was created.

INLI #2 on Inv #BTSAL3644e Suffix = EDI, has 1 linked holds.
Invoice # BTSAL3644b Suffix = EDI, was created.

INLI #4 on Inv #BTSAL3644b Suffix = EDI, has 2 linked holds.
Invoice # BTSAL3644d Suffix = EDI, was created.

Invoice # BTSAL3644a Suffix = EDI, was created.
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End processing EDI 810 file: testsal3644d.txt

o These messages indicate problems with the invoices:

[e]

Invoice #3014384848 may not have been created. Contact your Polaris sup-
port representative for assistance.

Inv#3014384848 has invalid IT101(s). Could not match an IT101/IT111
with a PO# in the system. Inv#3014384848 suffix=EDI was created. - The
invoice was created, but there were problems with some of the invoice line
items that did not match up with a purchase order.

The SA Profile defaults were used to create INLI# 5 on Inv #3014384848. -
An unlinked invoice line item was created using default data in the EDI
Invoice Defaults profile because no matching purchase order line item was
found. If a bibliographic record with a matching ISBN and title is found in the
Polaris database, it is used for the title of the invoice line item. If no matching
ISBN or title is found, the title is the default title in the profile, for example, No
matching PO line item was found.

The POLI# 5 on PO#BetterBooksPO1 is not linked to INLI# 4 on Inv#
3014384848 Suffix = EDI because it has the wrong status. An unlinked INLI
was created. - An invoice line item is created using information from the
matching purchase order line item, but the invoice line item cannot be linked
to the purchase order line item because the purchase order line item has a
status that prevents it from being linked.

Invoice#3014384848 Suffix = EDI was created. - The invoice was created,
but check the messages for individual invoice line items that may have prob-
lems.

The POLI# 5 on PO#BetterBooksPO1 is not linked to INLI# 6 on INV#
3014384848 Suffix = EDI because the quantity sent did not equal what was
ordered. An unlinked INLI was created. - This message appears when the
Hold partial shipment option is not selected in the EDI Invoice Defaults pro-
file. When an invoice line item indicates that the quantity sent does not equal
the quantity ordered, the invoice line item is created using information from
the matching purchase order line item, but it cannot be linked to the purchase
order line item because the quantities do not match.

EDI Inv# X Suffix= EDI has not been generated because Invoice line item
quantity sent does not equal the PO line item total quantity ordered and EDI
invoicing is set to hold partial shipment invoices. These PO lines are
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partials: [POLI ID X, POLI ID Y] - This message appears when the Hold partial
shipment invoices option is selected on the EDI Invoice Defaults profile, and
the EDI invoice indicates that for at least one line item, the quantity shipped
does not equal the quantity ordered.

Note:
To see the linked purchase order line item, use the Find Tool to search for
it by the purchase order line item ID.

EDI Invoice Default Dialog Box

The EDI Invoice Default dialog box appears when you double-click the EDI Invoice
Defaults profile on the Acquisitions/Serials tab in System Administration. If a supplier
creates an electronic invoice, the information in the EDI Invoice Default dialog box is
used to create the invoice automatically. See also: Set up EDI invoice defaults.

Use the EDI Invoice Default dialog box to:

Specify the title used to create EDI invoice line items when no matching purchase
order line item is found - Type a title in the Title box.

Select the default destination used to create EDI invoice line items when no match-
ing purchase order line item is found - Select the library in the Destination box.

Specify whether header charges are loaded automatically - Select Load supplier
header charges to automatically load the supplier header charges to the EDI
invoice. You can select only one fund to use for these charges if they are loaded
automatically. If this check box is unchecked, none of the supplier header charges
will be loaded automatically. When the shipment arrives, the supplier header
charges can be entered in the Invoice workform.

Specify the fund to use for header charges - If you selected Load supplier header
charges, select the fund to use for these charges in the Header fund box.

Select the fund used to create EDI invoice line items when no matching purchase
order line item is found - Select the fund in the Segment fund box.

Enter a note to include with any EDI invoice line item that is created when there is
no matching purchase order line item - Type the text in the Alert note box.

Specify whether matching purchase order line items are updated to Received -
Select Update linked PO line item to received to update linked purchase order line
items when the EDI invoice is created in Polaris. Clear the check box to wait to
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receive the line items when the actual shipment arrives. The the line items can be
received from the invoice.

Specify whether linked on-order items are updated - If the Update linked PO line
item to received box is checked, select Update on-order item circulation status to
update any linked on-order items to in-process. Clear the check box to leave the
linked items with a status of on-order until the shipment is received.Important:

If the Update on-order item circulation status check box is not selected, staff mem-
bers will never see on-order items with an in-process status; they are updated to a
status of In when they are checked in through circulation.

Prevent EDI invoices from being generated when the number of copies ordered and
received does not match - Select Hold partial receipt invoices if you do not want EDI
invoices to be generated automatically from the supplier’'s invoice files when the
number of copies sent does not equal the number of copies ordered on any of the
line items in the invoice. If this check box is checked, you can process these
invoices using the Process EDI Invoices workform.

Specify who should receive e-mail notices when the EDI invoices are received - In
the Email addresses box, enter the e-mail addresses of the individuals to notify
when the EDI invoice is received. You can enter multiple e-mail addresses sep-
arated by semicolons, but do not end an e-mail address with a semicolon unless
another address follows it.

Important:

If an e-mail address ends with a semicolon, the e-mail program expects
another e-mail address to follow and it fails on the blank address. The
invoices are created but no e-mails are sent.
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These charts list keyboard shortcuts you can use with Polaris Acquisitions workflows.

o General
Purchase Order Workform

Purchase Order Line Item Workform

Invoice Workform

Selection List Workform

FUNCTION KEYS
Workform help F1
New dialog box CTRL+N
Close workform ALT+F4
Save record CTRL+S
Print current view CTRL+P
Print current list view | CTRL+SHIFT+P

Purchase Order Workform

FUNCTION KEYS

Add Line Item CTRL+I

Claim Line Item CTRL+M

Cancel Line item CTRL+N
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Purchase Order Workform

Receive Line ltem

CTRL+R

Copy Line ltem

CTRL+T

Refresh list view

CTRL+E

Purchase Order Line Item Workform

FUNCTION KEYS
Receive Segment | CTRL+R
Copy Segment CTRL+Y
Modify Segment | CTRL+M

Invoice Workform

FUNCTION KEYS
Add Line Item CTRL+I
Receive Line ltem | CTRL+R
Credit Line Item CTRL+E
Pay Line Item CTRL+Y
Refresh list view CTRL+E

Selection List Workform

FUNCTION KEYS
Add Line Item CTRL+I
Delete Line Item CTRL+D
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Selection List Workform

Refresh list view CTRL+E

Copy segment data| CTRL+N
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Acquisitions Reports

To access Acquisitions reports, select Utilities from the Polaris Shortcut Bar, and select
Reports and Notices, Acquisitions.

« Advanced Shipment Container Content - Lists all items found in a specific package
or container for which the supplier has sent an EDI ASN file. Type or scan the 18-
digit SSCC tracking barcode in the Report Wizard window. The header shows the
date shipped. The report is sorted by title, and it includes the following information:
title; author; ISBN or UPC; purchase order number and suffix; purchase order line
item ID; and the total quantity sent.

« Advanced Shipment Containers Not Yet Received - Lists all items found in a pack-
age/container for which the supplier has produced an ASN, but which has not yet
been received through the ASN workform. To generate the report, enter the sup-
plier's SAN (with or without hyphens) in the Report Wizard dialog box. The report is
grouped by tracking barcode, and sorted by title, then purchase order number. It
lists the tracking barcode, PO#/Suffix, Title/Author/ISBN (UPC), PO Line ID, Qty
Sent, and the Date Shipped.

« Advanced Shipment Notification Log - The Advanced Shipment Notification log dis-
plays all titles received via ASN for a supplier and line item status date range. To
generate the report, enter the Supplier SAN (with or without the hyphen), the Line
item status start date, the Line item status end date, and press Enter or click Sub-
mit. The line item status date is the date the line item'’s status was updated to
Received (all segments were received via ASN).

The report lists purchase order line items that have segments received via ASN
within the time period (including the start and end dates) for the specified supplier.
It includes the following columns of information sorted by purchase order number,
then title, then carton tracking number: PO # / Suffix; Title / Author / ISBN (UPC);
Tracking Barcode; POLI ID; Ord - Total quantity ordered from the purchase order
line items; Sent - Total quantity shipped by the supplier; Rec - Total quantity of all
received purchase order line item segments; ASN Rec - Total quantity of purchase
order line item segments received using the Receive ASN Shipments workform;
Note - If the shipped quantity was adjusted, a note appears in this column. The
report is printed in landscape page orientation.
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Average Days On Order by Supplier and Material Type - Shows how long suppliers
take to fulfill orders. For each supplier, it shows the material type, the date ordered,
the date received, and the destination library.

Average Material Cost by Supplier - Compare suppliers by the type of material pur-
chased. It shows the average price of invoiced items for each supplier, according to
material type.

Canceled Titles by Supplier - Each canceled title is listed with its ISBN/ISSN, quant-
ity, amount (price), purchase order number, and line number.

Check In Shelf-Ready Materials - For each branch listed, the report contains the fol-
lowing information:

Purchase order line item segment receipt information: Purchase order number and
suffix; Title and author; Purchase order line ID number and Segment ID number;
Fund; Quantity ordered/Quantity received

Comments: If the line item segment was split because fewer copies were received
than were ordered, a note appears in this section.

Item check in information: The date and time that the item was checked in using
the Receive Shipment workform; the workstation name where the check in was
done; the user name of the staff member doing the check in; item’s barcode, title,
author, ISBN/UPC, item ID, assigned branch abbreviation

Claims Ready for Cancellation - Lists items that should be cancelled because the
maximum number of claims have been generated, and the item still has not been
received. If your library has chosen to automatically cancel items after the claim
cycle, the items will not appear on this report.

Currency Exchange Rates - For each library organization selected, the report shows
the foreign currency, the exchange rate, the last modified date, and the user who
last modified the exchange rate for that organization and foreign currency.

Electronic Invoice - Specify the date range and the supplier SAN to see the EDI
invoices. For each invoice, the report lists the invoice date, the invoice number, the
purchase order number, the currency (if a currency other than the base currency
was used), the date shipped, and the library account’s SAN ID. Under the invoice
information are the details for each purchase order line item, including the pur-
chase order line ID, the ISBN, the title, the quantity, the discount and retail prices,
the line item’s purchase order number, and the discount percentage. The report’s
page orientation is landscape.

Electronic Purchase Order Acknowledgment - An electronic purchase order acknow-
ledgment (POA) is the supplier's response to an electronic purchase order that the
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library sent. A Polaris utility scans the supplier's FTP server for acknowledgments
and invoices. If a purchase order has been sent and an acknowledgment is on the
supplier's server, the utility downloads the file to the C:\Polaris Reports\EDINew
directory (or another directory your library has specified to store these files). The
information in the downloaded file is used to create this report.

Use this report to identify the status of titles electronically transmitted in a pur-
chase order. The acknowledgment status codes in the report vary according to sup-
plier. You can also refer to the report to manually adjust a purchase order in Polaris
to reflect the current status of on-order titles. Each purchase order confirmed in the
report begins a new page, and the information on the page is grouped by line item
status. The report’s page orientation is landscape. To run the report, select a
branch (or select All) from the Organization list, enter the start date, end date, and
the supplier's SAN without a hyphen. The supplier's SAN is in the Supplier record.

Encumbrances and Expenditures by Supplier - Use this report to inform materials
suppliers of how much money has been spent (expenditures) and how much
money the library plans to spend (encumbrances) for a fiscal year. The report lists
suppliers by SAN, and suppliers that share the same SAN are grouped together and
listed in alphabetical order. If no SAN is found in the supplier record, the supplier
displays individually on the report. The encumbrances and expenditures amounts
are sub-totalled for each supplier account, and then totaled for the supplier group.

Note:
If your library supports more than one fiscal year hierarchy for the same
collection, the report should be run for each fiscal year hierarchy.

Suppliers are listed on the report if they are linked to:

« Purchase order line items for which amounts have been encumbered in
funds linked to the selected fiscal year.

« Invoice line items for which amounts have been expended from funds
linked to the selected fiscal year.

To run the report, select a single branch or all branches (you cannot select
multiple branches) under Parameters. The fiscal year records for the selected
branch (or all branches) are listed. Then, select a fiscal year from the list, and
press Enter or click Submit.
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« Expenditures by Fund and Material Type - Use this report to see expenditures
grouped by funds (linked to the selected fiscal year) that were used to pay for
items (items linked to invoice line item segments).

To run the report, first select a branch, multiple branches or all branches. If your lib-
rary’s acquisitions tasks are done centrally, select multiple branches or all
branches. When multiple branches are selected, the funds are sub-totaled without
branch grouping. If your library’s acquisitions tasks are done decentrally, select a
single branch to see the fund expenditures for that branch. Next, select the fiscal
year. Only one fiscal year can be selected for each report. If the branch uses mul-
tiple fiscal years, a separate report must be run for each fiscal period.

Each fund grouping displays the fund’s name and alternative name in a heading.
Under the fund heading, the report lists the following information in columns from
left to right as follows:

o Material type - The material types are sorted alphabetically within the fund
group. (This is the item record’s current Material Type, not the linked bib-
liographic record’s Type of Material (TOM).) ltems are counted unless they
have been permanently deleted from the database.

o Purchased - The number of items of each material type that were paid for
using the listed fund. The total in the Purchased column shows the total num-
ber of items of all material types purchased using the listed fund.

o Check-Outs - The number of check out transactions for each material type.
The total in the Check-Outs column shows the total number of check outs for
items of all material types purchased using the listed fund.

o Amount paid - The dollar amount paid for the items by material type. The
total in the Amount paid column is the total for items of all material types
paid for using the listed fund.

« Expenditures by Material Type and Fund - Use this report to see expenditures
grouped by material type and then sorted by fund within the material type group-
ing. To run the report, first select a branch, multiple branches or all branches. If
your library’s acquisitions tasks are done centrally, select multiple branches or all
branches. When multiple branches are selected, the funds are sub-totaled without
branch grouping. If your library’s acquisitions tasks are done decentrally, select a
single branch to see the fund expenditures for that branch. Next, select the fiscal
year. Only one fiscal year can be selected for each report. If the branch uses
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multiple fiscal years, a separate report must be run for each fiscal period.

Each material type grouping displays the material type heading. Under the material
type heading, the report lists the following information in columns from left to right
as follows:

o Fund - The funds are sorted alphabetically within the material type group.

o Purchased - The number of items of this material type that were paid for
using the fund. The total in the Purchased column shows the total number of
items with this material type paid for by any of the listed funds.

o Check-Outs - The number of check out transactions for each fund. The total
in the Check-Outs column shows the total number of check outs for items
with this material type purchased using any of the listed funds.

o Amount paid - The dollar amount paid for the items by fund. The total in the
Amount paid column is the total for items with this material type that were
paid using any of the listed funds.

Fund Hierarchy Report - Lists the funds for the selected fiscal year in a hierarchical
view (similar to the Fund Explorer view) with sub-funds listed under top-level funds.
The top of the report displays the fiscal year's total amount budgeted, encumbered,
expended, available and the total percentage used. If your library orders centrally,
you can select the fiscal year for the central processing organization, and the
report will display all the top-level funds linked to the selected fiscal year with the
subfunds under them. If your library orders decentrally, you can select the fiscal
year for a branch, and all the top-level funds linked to the fiscal year will be listed
with their subfunds under them. For each top-level fund listed, the following totals
are displayed: Total Allocated, Total Encumbered, Total Spent, Total Unspent,
Unspent = Total Allocated minus Spent. The totals include all the amounts for the
subfunds added together.

Fund Summary Report - Lists the fund activity for the selected fiscal year. The top
of the report displays the fiscal year’s total amount budgeted, encumbered, expen-
ded, available and the total percentage used. If ordering is done centrally, the user
selects the fiscal year for the central processing organization, and all the funds
linked to the fiscal year are listed. If ordering is done decentrally, the user selects
the fiscal year, and the funds are grouped by branch. The funds are listed with the
totals for each individual fund.
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Fund Transaction Comparisons - Lists any discrepancies between the amount dis-
played in the fund balances in the Fund workform and amounts that include
manual fund adjustments to encumbrances or expenditures.

Fund Transaction History - Lists the entire transaction history for a fund.

Funds by Group Name - Lists the library’s fund activity for a specified date range
by fund group name. Enter a part or whole fund name, or a portion of a word within
a fund name. To see the activity for the current fiscal year, enter the exact start and
end dates for the current fiscal year. The fund activity is available only for open
fiscal years.

Invoice Title, Status and Funds - Lists funds according to the invoice line item seg-
ment status.

ltems by Approval Plan - Lists items purchased using approval plans within a spe-
cified date range, including the material type, unit price, and number of copies for
each title ordered under an approval plan.

Items by Blanket Plan - Lists items purchased using blanket plans within a spe-
cified date range. It lists the material type, unit price, and number of copies for
each title ordered under a blanket plan.

Items by Donor Fund - Lists items purchased with donor funds within a specified
date range, including the material type, unit price, and number of copies for each
title ordered under a donor fund.

Items Ordered by Deposit Account Fund - Lists items purchased with deposit
account funds within a specified date range, including the material type, unit price,
and number of copies for each title ordered under a deposit account fund.

List of Funds by Fiscal Year - Lists the fiscal year and fund hierarchy for each lib-
rary for all open fiscal years and funds. It includes the total amount allocated; the
total currently encumbered and expended; the free balance; and the total amount

remaining for each fund listed. The Report Parameters window displays the fiscal
years according to the selected Organization(s).

List of Suppliers by Owning Branch - The supplier information includes the supplier
SAN (Standard Address Number), library account number, order address, payment
address, and claim address.

Number of Titles by Supplier - The number of titles that were ordered from a sup-
plier over a specified period of time.

Outstanding Claims by Supplier - Lists unresolved claims made for titles that were
ordered but not received.
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« Outstanding Orders - Lists purchase orders that are pending or have not been paid.
It is useful to run this report to see the outstanding orders before running the Fiscal
Year Rollover Utility. For each purchase order listed, the report shows the purchase
order number, order type, ordering library, and the total amount of the purchase
order. For each title ordered, the report shows the number of copies ordered for
each destination/collection.

To run the report, select the organization for which you want to list the outstanding
orders, and select the start and end dates to define a date range. You can limit the
report output further by selecting a fiscal year.

« PO Title Status and Fund - Use this report to see the status of purchase orders. It
lists fund encumbrances and disencumbrances, according to the purchase order
line item segment statuses (canceled, on order, pending, received) and payment
statuses (open, paid, or prepaid). In the Report Wizard dialog box, select the organ-
ization, payment status, and purchase order status. Then, specify the payment
status start and end dates, and the purchase order status start and end dates.

« Preliminary Level Bibliographic Records - Identifies preliminary bibliographic
records created in Acquisitions, so these records can be fully cataloged. When bib-
liographic information is entered in the Description fields of a Purchase Order Line
Item (either manually or using Titles to Go), a preliminary bibliographic record is
created with an encoding level of 5 (partial or preliminary) in the Leader position
17. The report identifies any bibliographic record with Leader position 17=5, and
other details like Title, ISBN, and the number of the linked purchase order. The pur-
chase order must have been released for it to appear in this report. If there is
invoice data, it is included in the report.

« Shelf Ready ltems Not Received in Acquisitions - Use this report to see purchase
order line items that have not been updated to Received but the linked shelf-ready
items have been checked in. The report lists any purchase order line item segment
with a status of Pending, Cancelled, Closed, Currently Received or Received that
has linked Items with a circulation status other than On-Order.

« Supplier Performance Report- Use this report to see the number of items ordered
and received; the fill rate; and the number of items canceled and claimed. Select
the library or branch for which you want to see the supplier data, and select the
date range.

« Uncataloged Titles with Holds - Use this report to expedite the cataloging of
received items that have hold requests. It identifies titles that had no hold requests
at the time they were received, but then hold requests were made later on these
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received items. The report shows the bibliographic record ID number, the title,
author, format, received date, and the number of holds. The report is sorted in des-
cending order by the purchase order line item’s receipt date (most recent first), then
by title in ascending order. An uncataloged title appears in the report if all items
linked to the purchase order line item have a status of In-Process or On-Order, and
at least one item has a status of In-Process. This status means that at least one
copy of the title in the purchase order line item has been received. Also, the hold
requests must have a status of Active to appear on the report.

Note:

The Holds Purchase Alert Circulation report is useful in making purchasing
decisions because it lists titles that are requested frequently, but have too
few items to meet the demand. To generate the report, select the Utilities
menu from the Polaris Shortcut Bar. Then select Reports and Notices,
Circulation, Holds, Holds Purchase Alert. For more information, see
Circulation Reports.
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Glossary

0
006 field

Fixed-length Data Elements - Additional Material Characteristics: This field con-
tains 18 character positions (00-17) that provide for coding information about
special aspects of the item being cataloged that cannot be coded in field 008
(Fixed-Length Data Elements). It is used in cases when an item has multiple char-
acteristics. It is also used to record the coded serial aspects of nontextual con-
tinuing resources. The field has a tree structure, whereby the code given in
006/00 (Form of material) determines the data elements defined for subsequent
character positions. Except for code s (Serial/Integrating resource), the codes in
field 006/00 correspond to those in Leader/06 (Type of record). For each occur-
rence of field 006, the codes defined for character positions 01-17 will be the
same as those defined in the corresponding field 008, character positions 18-34.
Configurations of field 006 are given in the following order: books, computer
files/electronic resources, maps, music, continuing resources, visual materials,
and mixed materials.

007 field
Physical Description, Fixed Field - This field contains special information about
the physical characteristics in a coded form. The information may represent the
whole item or parts of an item such as accompanying material. The data ele-
ments in field 007 are positionally defined and the number of character positions
in field 007 depends upon the code contained in 007/00. Character position 00
contains a code that identifies the category of material. The fill character (|) is
not allowed in this position. The fill character may be used in any other character
position when the cataloging agency makes no attempt to code the position.
The categories of material for which field 007 is applicable in bibliographic
records are presented in the following order in the field description: map, elec-
tronic resource, globe, tactile material, projected graphic, microform, nonprojected
graphic, motion picture, kit, notated music, remote-sensing image, sound record-
ing, text, videorecording, and unspecified.
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008 field
Fixed-length Data Elements - General Information This field contains 40 character
positions (00-39) that provide coded information about the record as a whole and
about special bibliographic aspects of the item being cataloged. These coded
data elements are potentially useful for retrieval and data management pur-
poses. The data elements are positionally defined. Character positions that are
not defined contain a blank (#). All defined character positions must contain a
defined code; for some field 008 positions, this may be the fill character (]). The
fill character may be used (in certain character positions) when a cataloging
organization makes no attempt to code the character position. The fill character
is not allowed in field 008 positions 00-05 (Date entered on file). Its use is dis-
couraged in positions 07-10 (Date 1), 15-17 (Place of publication, production, or
execution), and the 008 position defined for Form of item (either position 23 or
29 depending upon the 008 configuration). Character positions 00-17 and 35-39
are defined the same across all types of material, with special consideration for
position 06. The definition of character positions 18-34 was done independently
for each type of material, although certain data elements are defined the same in
the specifications for more than one type of material. When similar data ele-
ments are defined for inclusion in field 008 for different types of material, they
occupy the same field 008 character positions.

A

added entry
A secondary entry to the main entry in a MARC record.

approval plan
An arrangement with a publisher or vendor to send materials automatically. With
an approval plan, it is not necessary for the library to order each title individually,
and titles that are not considered appropriate may be returned by the library. An
approval plan with a vendor is usually an agreement that the library will receive
current imprints selected for the library on the basis of a detailed profile.

ASN (Advanced Shipping Notice)
An advance shipping notice or advance ship notice (ASN) is an electronic noti-
fication of pending shipments that is provided by a supplier after an EDI order is
received and processed. If the supplier has the capability to produce ASNs (X12
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transaction set 856), the Polaris EDIAgent utility retrieves the shipment inform-
ation, and loads the data into Polaris. This enables users to receive materials in
Polaris by scanning the tracking barcode on the outside of the carton.

B

blanket plan
A blanket plan (also called a blanket order) is most commonly used for ordering
all materials or a specific subset of materials that are published by an organ-
ization. In contrast with approval plans, blanket plans do not generally allow
return privileges with simple deductions from the invoice. With blanket plans,
quality is less important than comprehensiveness of coverage. Blanket plans can
be as narrow as a specific publisher’s series or as broad as a request to send all
material of a particular type or on a particular subject.

blind reference
1) An authority link (see or see also - 4xx and 5xx respectively) which points to an
authority heading that does not exist in the database. 2) An authority heading
(1xx) to which no bibliographic records are linked.

C

cataloging source
A code stored in tag 040 Sa that tells who created the record. These codes are
governed by the MARC code list for libraries.

chronology
The date(s) used by the publisher on a serially-issued bibliographic unit to help
identify or indicate when it was published. The chronology may reflect the dates
of coverage, publication, or printing.

content designators
Tags, indicators, and subfield codes in a MARC record.
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D

delimiter
A separate character used in conjunction with a subfield code and introduces
each subfield in a variable field.

deposit account
A deposit account is an account with a vendor that allows customers to pay all or
a portion of the estimated annual billing in advance. Depending on the amount
prepaid, the typical discount is from 1.5% to 4.5% more than with a regular plan,
where invoices are paid after the receipt of titles.

diacritical mark
Any of various marks, such as a macron or cedilla, added to a letter or symbol to
indicate its pronunciation or to distinguish it in some way.

E

enumeration
The designation reflecting the alphabetic or numeric scheme used by the pub-
lisher on an item or assigned when the holdings statement is created to identify
the individual bibliographic or physical parts and to show the relationship of
each unit to the unit as a whole.

express registration
Entering patron information during the check-out process as a service to new,
unregistered patrons.

F

first available copy requests
Hold requests for specific issues of a serial title (such as the May 2015 issue of
Horticulture Magazine ) or specific parts of a multi-part title (such as the first sea-
son of a television series on DVD).

© 2020 Innovative Interfaces, Inc.
Page 126



Automated Acquisitions Guide

form subdivision
A division of a subject heading which brings out the form of the work. For
example, in the headings: Internet (Computer network) - Periodicals Library tech-
nicians - Bibliography

free days
A value applied at normal and bulk check-in, renewal, and offline that allows you
to omit a specified number of days from the overdue fine calculation.

G

geographic qualifier
The name of a larger geographic entity added to a local place name. For
example, in the headings: Cambridge (Mass.) Toledo (Spain)

geographic subdivision

A subdivision which limits a topical subject heading to a specific geographic loc-
ation. For example, in the headings: Women - Peru Libraries - New York (State)

M

monographic series
A group of monographs with a collective title in addition to their individual titles.
The individual titles may or may not be numbered. The collective title is generally
found on the title page or the cover of each monograph.

R

RTF
Requests-To-Fill or RTF processing sends hold requests to designated libraries in
a specified order. A library chooses to fill or deny the request. The request is
routed until it is filled, it expires, or every library denies it.
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)

SICI
The colloquial name for Serial Item and Contribution Identifier. The SICl is the
SISAC bar code. The SICl incorporates the ISSN and is used on scholarly, tech-
nical, medical and other subscription based serials.

SISAC

Serials Industry Systems Advisory Committee. This committee was instrumental
in creating the supporting documentation for the NISO z39.56 standard.

standing order
An order placed with a vendor or the publisher directly for all publications in a
series, all volumes in a set, or all publications of a single publisher.

T

trapped
An item is said to be trapped for a hold when an item that fills a request is
scanned at circulation and the system links the item to a specific request, either
automatically or by displaying a message that prompts you for a decision.
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Index

$9
system-supplied 72
$h
970 subfield for copy-level information 14
characters 94
copy-level code in 970 tags 94
definition 94

020 tag

import profile 93

price in subfield ¢ 14,94
024 tag

import profile 93
040 tag

used in determining overlay 91

852 tags
holdings information in 73

Polaris default (with item creation) profile 73
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970 tags
$h 94
Sh copy level code 14
970 tag of the bibliographic record 94
purchase order line item segments 94

subfields that create segments 94

acquisitions shortcut keys
reference 112
adjusting funds
releasing a purchase order 33
ASN
overview of receiving 37
EDI invoice creation 60
implementing with a current EDI supplier 67
receiving a shipment using 57
receiving partial shipments 57
reports 115
using to receive shipments 57
authority control
automatically search remote databases during import 71
performing when importing 71
authority records

importing with deleted status 72
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automatic authority control

searching remote database during import 71

bibliographic records
created via acquisitions, report 121
bulk add to purchase order
unit price from bib when no 970 Sc 95
Bulk add to purchase order or selection list
Mark 970 data as processed
results of setting parameter to Yes or No 25
bulk adding
970 tags to create segments 94
bibliographic records with multiple ISBNs 94
overview 93
record sets in Find Tool to purchase orders 25
setting administration options 95
titles to new purchase order 25
using defaults for purchase orders 26
bulk adding bibs

MARC tags checked for unit price when no 970 Sc 15

most-recently added UPC displayed in Other number box 94
PO line item displays the most-recently added ISBN (020Sa) 94

bulk changing

items, on order 61
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call numbers
include in enriched EDI orders 31
checking in items (circulation)
receiving new shelf-ready items, procedure 52
checking in shelf-ready items
procedure 52
collections
abbreviations in 970 tags 94
currency

exchange rates report 116

data conventions

embedded holdings data 73

EDI
invoice and acknowledgement reports 116
troubleshooting FTP connection 8
EDI invoice e-mail
message details 46, 107
EDI invoices
ASN 60
bibliographic-level holds 46, 107

e-mail 41
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linking to purchase order line items manually 51, 103
processing for partial shipments 44, 105
receiving 42,49,100
setting defaults 38

EDI ordering
call number setup for on-order items 11
EDI purchase order number maximum length 32
file information on purchase order 34
including item call numbers in enriched 31
processing partial shipment invoices 44, 105
receive using ASN 37
retransmitting 35
setting up supplier record for 68
setting up, overview 5

EDI transmission mode
setting active or passive FTP 17

EDIAgent
files retrieved by 6
overview 6

EDIAgent logs
described 8
examples 8

EDIFTP logs
described 8

electronic data interchange

See EDI 67
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email
EDI invoice 41
EDI invoice details 46,107
embedded holdings
data entry conventions 73
defaults for creating item records 73
subfield formats 73
encoding levels
defined 78
values that allow or disallow overlay during import 78
viewing from bibliographic record 78
enriched EDI orders
described 96
include call numbers 31
exclamation point
purchase order line items with multiple ISBNs 95
expenditures
reports 117
express importing
described 19

FTP
EDI troubleshooting 8
message examples 8

setting EDI transmission mode 17
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fund transactions
viewing from a released purchase order 32
funds
adjusting overencumbrances when releasing a purchase order 33
listed by fiscal year, report 120
reports 119

hold requests
bibliographic and EDI invoices 46, 107
holdings data

defaults for creating item records 73

Import Jobs Queue
printing an import report from 19
importing
defaults for invalid subfields and indictors 71
defaults for item record creation 73
printing a report on an import job 19
processing time 19
specifying source file location 19
subfield formats for holdings 73
importing authority records
deleted status 72
importing bibliographic records

automatically search remote authority database 71
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performing authority control 71
invoices
adjusting to match supplier's 36
creating item records from 43
receiving 42
setting EDI defaults 38, 40
invoices, EDI
processing partial shipment invoices 44, 105
receiving 49, 100
item records
creating from an invoice 43
creating from embedded holdings 73
generating on-order 30
including call numbers in shelf-ready materials 31
item record create error 33
updating when receiving purchase orders and invoices 61
items
funds used to purchase, report 120

receiving shelf-ready, procedure 52

keyboard shortcuts

acquisitions 112

locations (branches)

abbreviations in 970 tags 94
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on-order item records

call number setup for 11

generating 30

unit (list) price copied from line item 30

updating by bulk changing barcode and call humber 61
orders

See purchase orders 23
overencumbrances

adjusting fund when releasing a purchase order 33
overexpenditures

when releasing prepaid purchase order 34

P

partial shipment EDI invoices
processing 44,105

Polaris Default (with item creation) import profile
holdings tag 73

Polaris EDIAgent
See EDIAgent job 6

price
bib tags checked if no 970 Sc 15
copied from bib during bulk add without 970 Sc 95
in 020 tag subfield c 14,94

unit (list) copied to on-order items 30
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Process EDI Invoices workform
described 104
purchase order line item segment ID
displaying in a Z39.50 search 96-97
purchase order line item workslips
printing from the Receive ASN Shipments workform 59
purchase order line items
bibliographic records with multiple ISBNs 94
receiving EDI 61
purchase order numbers
supplier limits 30
purchase orders
bulk adding titles to new 25
bulk adding titles, overview 93
limit on purchase order number length 32
pending and unpaid report 121
releasing 30
selecting and importing titles from supplier, overview 23
specifying the bulk add error report path 27
status report 121
transmitting via EDI 34
using defaults in bulk add 26

viewing fund transactions 32

receive

ASN shipments 57
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partially received ASN shipments 57
Receive ASN Shipments workform
printing workslips 59
receiving
invoice line items from an invoice 42
overview of Advanced Shipping Notice (ASN) 37
purchase order line items sent via EDI 61
updating linked item records 61
using the Advanced Shipping Notice (ASN) 57
record sets
creating purchase orders using 25
releasing purchase orders
alerts 30
supplier accepts EDI 31
viewing fund transactions 32
reports
Acquisitions 115
reports (cataloging)
import job 19
retransmitting a purchase order

EDI File Sent Warning message 35

selection list line items
bibliographic records with multiple ISBNs 94
selection lists

bulk adding titles, overview 93
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shelf-ready items
allowing supplier to search Polaris database 96-97
including call numbers 31
not received via acquisitions report 121
shelf-ready materials
report 116
shipments
processing partial EDI invoices 44,105
shortcut keys
acquisitions reference 112
source files
importing cataloging records 19
subfield 9 and text
system-supplied 72
subfields
format for embedded holdings 73
supplier records
setting up for EDI orders 68
suppliers
implementing ASN processing with a current EDI supplier 67

reports 116

template codes
in 970 Sh 94
templates (item record)

missing required fields 33
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transmitting

purchase orders via EDI 34

uncataloged titles with holds

report 121

Z39.50 and acquisitions

allowing suppliers to search the Polaris database 96-97
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